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1

Introducing the VCS agents
for SQL and NetApp
This chapter includes the following topics:
■

About the VCS agents for SQL and NetApp

■

About the VCS hardware replication agent for NetApp

■

About the VCS database agent for Microsoft SQL Server

■

About the monitoring options

■

How the agents make SQL Server highly available

■

Typical SQL Server 2005 configuration in a VCS cluster

About the VCS agents for SQL and NetApp
The VCS agent for Microsoft SQL Server provides high availability to SQL Server.
The VCS hardware replication agent for NetApp SnapMirror enables configuring
NetApp filers over an iSCSI or Fibre Channel (FC) connection in a VCS cluster
environment. Both the agents work together to provide high availability and
disaster recovery to SQL Server in environments that use NetApp filers for shared
storage. The agents also support disaster recovery configurations set up using
the VCS Global Cluster Option and NetApp SnapMirror for data replication.
In a typical configuration, the agents are installed on each node in the cluster.
The nodes are connected to the NetApp filers through a dedicated (private) storage
network. VCS nodes are physically attached to the NetApp filer via an ethernet
cable supporting iSCSI or FC as the transport protocol.
Figure 1-1 shows a typical VCS configuration in a NetApp storage environment.
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Figure 1-1

Typical VCS configuration in a NetApp storage environment

This chapter provides an overview of the agents. For more information about the
agents, refer to their resource type definitions and attribute definitions.

About the VCS hardware replication agent for NetApp
The VCS hardware replication agent for NetApp provides failover support and
recovery in environments employing NetApp filers for storage and NetApp
SnapMirror for replication.
The agent monitors and manages the state of replicated filer devices and ensures
that at a time only one system has safe and exclusive access to the configured
devices.
The agent can be used in local clusters, single VCS replicated data clusters, and
multi-cluster environments set up using the VCS Global Cluster Option (GCO).
The VCS agents for NetApp are as follows:
■

NetAppFiler agent

■

NetAppSnapDrive agent

■

NetAppSnapMirror agent

About the NetApp Filer agent
The NetApp Filer agent monitors the state of the filer device. The agent is
represented by the NetAppFiler resource type in VCS. NetAppFiler resources are
persistent, meaning that they are not brought online or taken offline.
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NetApp Filer agent function
The NetApp Filer agent function is as follows:
Monitor

Performs the following tasks:
Verifies the state of the filer attached to the host by sending an
ICMP ping command to the filer. If the filer does not respond, the
agent reports the state of the filer as faulted.
■ Opens a filer connection and checks if ONTAPI version is supported
by the filer. If the connection fails or the ONTAPI version is not
supported, the agent reports the state as offline.
■

About the NetApp SnapDrive agent
The NetApp SnapDrive agent monitors, connects, and disconnects filer volumes.
You can configure the agent to use the iSCSI or the FC protocol.

NetApp SnapDrive agent functions
The NetApp SnapDrive agent functions are as follows:
Online

Connects a virtual disk (LUN) using an iSCSI or an FC initiator. The
agent presents the LUN as a locally-attached drive to the host. The
agent also removes LUN-host mappings made before the online
operation.

Offline

Disconnects the virtual disk (LUN) from the host.

Monitor

Verifies that the specified virtual disk (LUN) is connected to the host.

Open

Verifies that there is connectivitiy to the filer. It also checks that the
VCS Helper service is running with the same privileges as the
SnapDrive service.

Clean

Attempts to forcibly disconnect a virtual disk (LUN).

About the NetApp SnapMirror agent
The NetApp SnapMirror agent monitors the replication state of filer devices.
When a failover occurs, the agent reverses the direction of replication. The agent
supports the replication modes supported by NetApp. The agent supports
asynchronous, semi-synchronous, and synchronous modes of replication. You
can set the mode of replication using the SyncMode agent attribute.
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NetApp SnapMirror agent functions
The NetApp SnapMirror agent functions are as follows:
Online

If the state of the local filer device is SOURCE, the agent creates a lock
file to indicate that the resource can come online. This effectively
makes the devices writable for the application.
If the state of the local filer is SNAPMIRRORED, the agent attempts
to reverse the direction of replication by changing the state of the
local filer to SOURCE and that of the original source to
SNAPMIRRORED.
If the original source filer is down, the agent performs a mirror
breakoff to enable local write access, if the filer is not already broken
off.
If the original source returns to life, you must resynchronize the data
manually. The online function touches a lock file if read-write access
is enabled successfully.

Offline

Removes the lock file. The agent does not perform any filer operations
because an offline entry point does not necessarily indicate an
intention to give up the devices.

Monitor

Verifies that the lock file exists. If the lock file exists, the monitor
function reports the status of the resource as online. If the lock file
does not exist, the monitor function reports the status of the resource
as offline.

Open

Removes the lock file thereby preventing potential concurrency
violation if the group fails over to another node.

Note: The agent does not remove the lock file if the agent is started
after an hastop -force command.
Clean

Removes the lock file. No filer operations are performed as taking the
resource offline does not indicate a pending role swap.

About the VCS database agent for Microsoft SQL
Server
The VCS database agent for Microsoft SQL Server provides high availability for
Microsoft SQL Server databases in a VCS cluster. The agent monitors Microsoft
SQL Server RDBMS and its services on a VCS cluster to ensure high availability.
The database agent also provides "active-active" support for SQL Server.
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The VCS database agent for Microsoft SQL Server also includes an MSDTC agent,
which provides high availability for MSDTC service used in distributed
transactions. The agent provides high availability for MSDTC service for SQL
Server 2005.
The agent detects an application failure if a configured virtual server becomes
unavailable. When this occurs, the SQL Server service group is failed over to the
next available system in the service group’s system list. The configured SQL
services and virtual server are started on the new system.

About the VCS database agent for SQL Server 2005
The agents for SQL Server 2005 monitor specific resources within the application,
determines the status of these resources, brings them online, and takes them
offline.
The VCS database agent for SQL Server 2005 includes the following:
Agent for SQL Server 2005
service

The agent provides high availability for SQL Server 2005
service.

Agent for SQL Server 2005 Agent The agent provides high availability for SQL Server 2005
service.
agent service.
Agent for SQL Server 2005
Analysis service.

The agent provides high availability for SQL Server 2005
Analysis service.

The VCS agent for Microsoft SQL Server does not provide an agent for monitoring
the SQL Server 2005 MSSearch service. Instead, the SQL Server 2005 MSSearch
service is monitored using a GenericService resource. Refer to Veritas Cluster
Server Bundled Agents Reference Guide for more information about GenericService
agent.

SQL Server 2005 service agent functions
The agent brings the SQL Server 2005 service online, monitors the status, and
takes it offline.
SQL Server 2005 service agent functions are as follows:
Online

Brings the SQL Server 2005 service online.

Offline

Takes the SQL Server 2005 service offline.

Clean

Forcibly stops the SQL Server 2005 service.
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SQL Server 2005 Agent service agent functions
The agent brings the SQL Server 2005 agent service online, monitors the status,
and takes it offline.
SQL Server 2005 Agent service agent functions are as follows:
Online

Brings the SQL Server 2005 Agent service online.

Offline

Takes the SQL Server 2005 Agent service offline.

Monitor

Monitors the SQL Server 2005 Agent service.

Clean

Forcibly stops the SQL Server 2005 Agent service.

SQL Server 2005 Analysis service agent functions
The agent brings the SQL Server 2005 Analysis service online, monitors the status,
and takes it offline.
SQL Server 2005 Analysis service agent functions are as follows:
Online

Brings the SQL Server 2005 Analsis service online.

Offline

Takes the SQL Server 2005 Analysis service offline.

Monitor

Monitors the SQL Server 2005 Analysis service.

Clean

Forcibly stops the SQL Server 2005 Analysis service.

About the agent for MSDTC service
The MSDTC agent comprises two parts; MSDTC client and MSDTC server. The
MSDTC client and the MSDTC server must not be configured on the same cluster
node.
The MSDTC agent brings the MSDTC service online, monitors its status, and takes
it offline. The agent provides high availability for the MSDTC service in a clustered
environment.
MSDTC agent functions are as follows:
Online

Brings the MSDTC service online.

Offline

Takes the MSDTC service offline.

Monitor

Monitors the MSDTC service.

Clean

Forcibly stops the MSDTC service.
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About the monitoring options
The VCS agent for Microsoft SQL Server provides two levels of application
monitoring: basic and detail. Basic monitoring queries the SCM to verify whether
the SQL Server services are continuously active. Detail monitoring updates a
temporary table in the SQL Server database to verify the availability of the database
instance.
Table 1-1

Methods of configuring detail monitoring for SQL databases

Method

Description

Script-based detail
monitoring

The SQL Server agent uses a script to monitor the status of the
database. If the script is successfully executed during
monitoring, the agent considers the database instance available.
If the execution fails, the database instance is considered not
available and, if the FaultOnDMFailure attribute is configured,
the service group fails over to the failover nodes.
A sample script is provided with the agent for the purpose. You
can customize the script to meet your configuration
requirements.
The script is located at:
%VCS_HOME%\bin\SQLServer2005\sample_script.sql
Here, %VCS_HOME% is the default installation directory for
VCS, typically it is C:\Program Files\Veritas\Cluster Server.
You should use a separate script for each SQL Server service
group that exists in the cluster. The script should exist on all
the nodes in the service group.

Note: If you provide input for both types of detail monitoring, DBList monitoring
takes precedence, and SQL script-based monitoring is not performed.
You can enable and configure detail monitoring by running the SQL Server 2005
Configuration Wizard for VCS. Refer to the instructions for configuring a SQL
Server service group for more information.
Note: If you start the SQL server services from outside VCS, then the SQL resource
will go in an UNKNOWN state, because the VCS agent monitors the computer
context of the services. If the SQL service is not started in the virtual server context
the resource goes in an UNKNOWN state. You must ensure that you start all the
SQL related services from within VCS.
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How the agents make SQL Server highly available
The VCS database agent for Microsoft SQL Server detects an application failure
if a configured virtual server becomes unavailable. The NetApp agents ensure
consistent data access to the node on which SQL Server instances are running.
This section describes how the agents migrate SQL Server to another node in local
clusters and in global disaster recovery configurations.

Local cluster configuration after a failover
When the VCS database agent for Microsoft SQL Server detects an application
failure, the SQL Server service group is failed over to the next available system
in the service group’s system list. The configured SQL services and virtual server
are started on the new system. The NetApp agents connect the virtual disks (LUNs)
that contain the SQL Server data to the new node; thus ensuring continuous
availability to SQL data.

Disaster recovery configuration after a failover
In a disaster recovery configuration, VCS first attempts to fail over the application
to a node in the local cluster. If all nodes in the local cluster are unavailable, or if
a disaster strikes the site, VCS attempts to fail over the application to the remote
site.
This involves the following steps:
■

Connecting the virtual disks (LUNs) to the target hosts (using the
NetAppSnapDrive agent).

■

Performing a mirror break, which enables write access to the target (using the
NetAppSnapMirror agent).

■

Reversing the direction of replication by demoting the original source to a
target, and begin replicating from the new source (using the NetAppSnapMirror
agent).

■

Starting the SQL services on the remote node (using the VCS database agent
for SQL Server).

Typical SQL Server 2005 configuration in a VCS
cluster
A typical SQL Server 2005 configuration in a VCS cluster involves two cluster
nodes accessing a shared storage. The SQL Server binaries are installed on the
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cluster nodes. The shared storage is used to store SQL Server data files and the
MSDTC log files. The cluster nodes access the shared storage. The shared storage
can be managed using NetApp suite of products.
The cluster nodes are configured to host the SQL Server 2005 resource, the SQL
Server 2005 agent service resource, the SQL Server 2005 MSSearch service
resource, and the SQL Server 2005 analysis service resource. The MSDTC resource
can be configured on the same cluster nodes. You need not configure an MSDTC
client if the MSDTC resource is configured on the same nodes that have SQL Server
2005 resource configured. However, if the MSDTC resource is configured on other
nodes, you must configure an MSDTC client to point to the virtual server name
of the MSDTC resource.
The following illustration depicts a two node cluster hosting a SQL Server service
group with the different services configured. MSDTC resource is also configured
on the same nodes.
Figure 1-2

Typical SQL Server 2005 configuration in a VCS cluster
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Chapter

2

Installing the VCS agents
for SQL Server and
configuring the cluster
This chapter includes the following topics:
■

About installing the VCS agents

■

Configuring the cluster using the Cluster Configuration Wizard

About installing the VCS agents
Install Veritas Cluster Server (VCS) on all the systems where you want to configure
the application. During installation, the product installer installs the VCS agents
required for making the applications highly available.
You must install the VCS agents before configuring the application with VCS.
Refer to the Veritas Cluster Server for Windows Installation and Upgrade Guide
for instructions.

Configuring the cluster using the Cluster
Configuration Wizard
After installing the software, set up the components required to run Veritas Cluster
Server. The VCS Cluster Configuration Wizard (VCW) sets up the cluster
infrastructure, including LLT and GAB, the user account for the VCS Helper service,
and provides an option for configuring the VCS Authentication Service in the
cluster. The wizard also configures the ClusterService group, which contains
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resources for notification and global clusters (GCO). You can also use VCW to
modify or delete cluster configurations.
Note: After configuring the cluster you must not change the names of the nodes
that are part of the cluster. If you wish to change a node name, run VCW to remove
the node from the cluster, rename the system, and then run VCW again to add
that system to the cluster.
Note the following prerequisites before you proceed:
■

The required network adapters, and SCSI controllers are installed and
connected to each system.
To prevent lost heartbeats on the private networks, and to prevent VCS from
mistakenly declaring a system down, Symantec recommends disabling the
Ethernet auto-negotiation options on the private network adapters. Contact
the NIC manufacturer for details on this process. Symantec recommends
removing Internet Protocol TCP/IP from private NICs to lower system overhead.

■

Verify that the public network adapters on each node use static IP addresses
(DHCP is not supported) and name resolution is configured for each node.

■

Symantec recommends that you use three network adapters (two NICs
exclusively for the VCS private network and one for the public network) per
system. You can implement the second private link as a low-priority link over
a public interface. Route each private NIC through a separate hub or switch
to avoid single points of failure. Symantec recommends that you disable TCP/IP
from private NICs to lower system overhead.

■

Use independent hubs or switches for each VCS communication network (GAB
and LLT). You can use cross-over Ethernet cables for two-node clusters. GAB
supports hub-based or switch network paths, or two-system clusters with
direct network links.

■

Verify the DNS settings for all systems on which SQL will be installed and
ensure that the public adapter is the first adapter in the Connections list.
When enabling DNS name resolution, make sure that you use the public
network adapters, and not those configured for the VCS private network.

■

The logged on user must have local Administrator privileges on the system
where you run the wizard. The user account must be a domain user account.

■

The logged on user must have administrative access to all systems selected
for cluster operations. Add the domain user account to the local Administrator
group of each system.
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■

If you plan to create a new user account for the VCS Helper service, the logged
on user must have Domain Administrator privileges or must belong to the
Domain Account Operators group.

■

When configuring a user account for the VCS Helper service, make sure that
the user account is a domain user. The VCS High Availability Engine (HAD),
which runs in the context of the local system built-in account, uses the VCS
Helper Service user context to access the network. This account does not
require Domain Administrator privileges.

■

Make sure the VCS Helper Service domain user account has "Add workstations
to domain" privilege enabled in the Active Directory.

■

Verify that each system can access the storage devices and each system
recognizes the attached shared disk.
Use Windows Disk Management on each system to verify that the attached
shared LUNs (virtual disks) are visible.

■

If you plan to set up a disaster recovery (DR) environment, you must configure
the wide-area connector process for global clusters.

■

If you are setting up a Replicated Data Cluster configuration, add only the
systems in the primary zone (zone 0) to the cluster, at this time.

To configure a VCS cluster using the wizard

1

Click Start > All Programs > Symantec > Veritas Cluster Server >
Configuration Tools > Cluster Configuration Wizard to start the VCS Cluster
Configuration Wizard.

2

Read the information on the Welcome panel and click Next.

3

On the Configuration Options panel, click Cluster Operations and click Next.

4

On the Domain Selection panel, select or type the name of the domain in
which the cluster resides and select the discovery options.
To discover information about all systems and users in the domain, do the
following:
■

Clear Specify systems and users manually.

■

Click Next.
Proceed to step 8.

To specify systems and user names manually (recommended for large
domains), do the following:
■

Select Specify systems and users manually.
Additionally, you may instruct the wizard to retrieve a list of systems and
users in the domain by selecting appropriate check boxes.
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■

5

Click Next.
If you chose to retrieve the list of systems, proceed to step 6. Otherwise,
proceed to the next step.

On the System Selection panel, type the name of each system to be added,
click Add, and then click Next.
Do not specify systems that are part of another cluster.
Proceed to step 8.

6

On the System Selection panel, specify the systems for the cluster and then
click Next.
Do not select systems that are part of another cluster.
Enter the name of the system and click Add to add the system to the Selected
Systems list, or click to select the system in the Domain Systems list and then
click the > (right-arrow) button.

7

The System Report panel displays the validation status, whether Accepted
or Rejected, of all the systems you specified earlier. Review the status and
then click Next.
Select the system to see the validation details. If you wish to include a rejected
system, rectify the error based on the reason for rejection and then run the
wizard again.
A system can be rejected for any of the following reasons:

8

■

System is not pingable.

■

WMI access is disabled on the system.

■

Wizard is unable to retrieve the system architecture or operating system.

■

VCS is either not installed on the system or the version of VCS is different
from what is installed on the system on which you are running the wizard.

On the Cluster Configuration Options panel, click Create New Cluster and
then click Next.
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9

On the Cluster Details panel, specify the details for the cluster and then click
Next.

Specify the cluster details as follows:
Cluster Name

Type a name for the new cluster. Symantec recommends a
maximum length of 32 characters for the cluster name.

Cluster ID

Select a cluster ID from the suggested cluster IDs in the
drop-down list, or type a unique ID for the cluster. The cluster
ID can be any number from 0 to 65535.

Note: If you chose to specify systems and users manually in step
4 or if you share a private network between more than one
domain, make sure that the cluster ID is unique.
Operating System From the drop-down list, select the operating system.
The Available Systems box then displays all the systems that are
running the specified operating system.
All the systems in the cluster must have the same operating
system and architecture. You cannot configure a Windows Server
2008 and a Windows Server 2008 R2 system in the same cluster.
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Available Systems Select the systems that you wish to configure in the cluster.
Check the Select all systems check box to select all the systems
simultaneously.
The wizard discovers the NICs on the selected systems. For
single-node clusters with the required number of NICs, the wizard
prompts you to configure a private link heartbeat. In the dialog
box, click Yes to configure a private link heartbeat.

10 The wizard validates the selected systems for cluster membership. After the
systems are validated, click Next.
If a system is not validated, review the message associated with the failure
and restart the wizard after rectifying the problem.
If you chose to configure a private link heartbeat in step 9, proceed to the
next step. Otherwise, proceed to step 12.

11 On the Private Network Configuration panel, configure the VCS private
network and then click Next. You can configure the VCS private network
either over the ethernet or over the User Datagram Protocol (UDP) layer using
IPv4 or IPv6 network.
Do one of the following:
■

To configure the VCS private network over ethernet, complete the
following steps:
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■

Select Configure LLT over Ethernet.

■

Select the check boxes next to the two NICs to be assigned to the private
network. You can assign a maximum of eight network links.
Symantec recommends reserving two NICs exclusively for the private
network. However, you could lower the priority of one of the NICs and use
the low-priority NIC for both public and as well as private communication.

■

If there are only two NICs on a selected system, Symantec recommends
that you lower the priority of at least one NIC that will be used for private
as well as public network communication.
To lower the priority of a NIC, right-click the NIC and select Low Priority
from the pop-up menu.

■

If your configuration contains teamed NICs, the wizard groups them as
"NIC Group #N" where "N" is a number assigned to the teamed NIC. A
teamed NIC is a logical NIC, formed by grouping several physical NICs
together. All NICs in a team have an identical MAC address. Symantec
recommends that you do not select teamed NICs for the private network.
The wizard configures the LLT service (over ethernet) on the selected
network adapters.
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■

To configure the VCS private network over the User Datagram Protocol
(UDP) layer, complete the following steps:

■

Select Configure LLT over UDP on IPv4 network or Configure LLT over
UDP on IPv6 network depending on the IP protocol that you wish to use.
The IPv6 option is disabled if the network does not support IPv6.

■

Select the check boxes next to the NICs to be assigned to the private
network. You can assign a maximum of eight network links. Symantec
recommends reserving two NICs exclusively for the VCS private network.

■

For each selected NIC, verify the displayed IP address. If a selected NIC
has multiple IP addresses assigned, double-click the field and choose the
desired IP address from the drop-down list. In case of IPv4, each IP address
can be in a different subnet.
The IP address is used for the VCS private communication over the
specified UDP port.

■

Specify a unique UDP port for each of the link. Click Edit Ports if you wish
to edit the UDP ports for the links. You can use ports in the range 49152
to 65535. The default ports numbers are 50000 and 50001 respectively.
Click OK.
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For each selected NIC, double-click the respective field in the Link column
and choose a link from the drop-down list. Specify a different link (Link1
or Link2) for each NIC. Each link is associated with a UDP port that you
specified earlier.
The wizard configures the LLT service (over UDP) on the selected network
adapters. The specified UDP ports are used for the private network
communication.

12 On the VCS Helper Service User Account panel, specify the name of a domain
user for the VCS Helper Service.
The VCS High Availability Engine (HAD), which runs in the context of the
local system built-in account, uses the VCS Helper Service user context to
access the network. This account does not require Domain Administrator
privileges.
Specify the domain user details as follows:
■

To specify an existing user, do one of the following:
■

Click Existing user and select a user name from the drop-down list.

■

If you chose not to retrieve the list of users in step 4, type the user
name in the Specify User field and then click Next.

■

To specify a new user, click New user and type a valid user name in the
Create New User field and then click Next.
Do not append the domain name to the user name; do not type the user
name as Domain\user or user@domain.

■

In the Password dialog box, type the password for the specified user and
click OK, and then click Next.

13 On the Configure Security Service Option panel, specify security options for
the cluster communications and then click Next.
Do one of the following:
■

To use VCS cluster user privileges, click Use VCS User Privileges and then
type a user name and password.
The wizard configures this user as a VCS Cluster Administrator. In this
mode, communication between cluster nodes and clients, including Cluster
Manager (Java Console), occurs using the encrypted VCS cluster
administrator credentials. The wizard uses the VCSEncrypt utility to
encrypt the user password.
The default user name for the VCS administrator is admin and the
password is password. Both are case-sensitive. You can accept the default
user name and password for the VCS administrator account or type a new
name and password.
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Symantec recommends that you specify a new user name and password.
■

To use the single sign-on feature, click Use Single Sign-on.
In this mode, the VCS Authentication Service is used to secure
communication between cluster nodes and clients by using digital
certificates for authentication and SSL to encrypt communication over
the public network. VCS uses SSL encryption and platform-based
authentication. The VCS high availability engine (HAD) and Veritas
Command Server run in secure mode.
The wizard configures all the cluster nodes as root brokers (RB) and
authentication brokers (AB). Authentication brokers serve as intermediate
registration and certification authorities. Authentication brokers have
certificates signed by the root. These brokers can authenticate clients
such as users and services. The wizard creates a copy of the certificates
on all the cluster nodes.

14 Review the summary information on the Summary panel, and click Configure.
The wizard configures the VCS private network. If the selected systems have
LLT or GAB configuration files, the wizard displays an informational dialog
box before overwriting the files. In the dialog box, click OK to overwrite the
files. Otherwise, click Cancel, exit the wizard, move the existing files to a
different location, and rerun the wizard.
The wizard starts running commands to configure VCS services. If an
operation fails, click View configuration log file to see the log.

15 On the Completing Cluster Configuration panel, click Next to configure the
ClusterService group; this group is required to set up components for
notification and for global clusters.
To configure the ClusterService group later, click Finish.
At this stage, the wizard has collected the information required to set up the
cluster configuration. After the wizard completes its operations, with or
without the ClusterService group components, the cluster is ready to host
application service groups. The wizard also starts the VCS engine (HAD) and
the Veritas Command Server at this stage.

16 On the Cluster Service Components panel, select the components to be
configured in the ClusterService group and then click Next.
Do the following:
■

Check the Notifier Option check box to configure notification of important
events to designated recipients.
See “Configuring notification” on page 31.
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■

Check the GCO Option check box to configure the wide-area connector
(WAC) process for global clusters.The WAC process is required for
inter-cluster communication.
Configure the GCO Option using this wizard only if you are configuring a
Disaster Recovery (DR) environment and are not using the Disaster
Recovery wizard.
You can configure the GCO Option using the DR wizard. The Disaster
Recovery chapters in the application solutions guides discuss how to use
the Disaster Recovery wizard to configure the GCO option.
See “Configuring Wide-Area Connector process for global clusters”
on page 33.

Configuring notification
This section describes steps to configure notification.
To configure notification

1

On the Notifier Options panel, specify the mode of notification to be configured
and then click Next.
You can configure VCS to generate SNMP (V2) traps on a designated server
and send emails to designated recipients in response to certain events.

2

If you chose to configure SNMP, specify information about the SNMP console
and then click Next.

Do the following:
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3

■

Click a field in the SNMP Console column and type the name or IP address
of the console.
The specified SNMP console must be MIB 2.0 compliant.

■

Click the corresponding field in the Severity column and select a severity
level for the console.

■

Click ‘+’ to add a field; click ‘-’ to remove a field.

■

Enter an SNMP trap port. The default value is "162".

If you chose to configure SMTP, specify information about SMTP recipients
and then click Next.
Do the following:

4

■

Type the name of the SMTP server.

■

Click a field in the Recipients column and enter a recipient for notification.
Enter recipients as admin@example.com.

■

Click the corresponding field in the Severity column and select a severity
level for the recipient.
VCS sends messages of an equal or higher severity to the recipient.

■

Click ‘+’ to add fields; click ‘-’ to remove a field.

On the Notifier Network Card Selection panel, specify the network information
and then click Next.

Do the following:
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■

If the cluster has a ClusterService group configured, you can use the NIC
resource configured in that service group or configure a new NIC resource
for notification.

■

If you choose to configure a new NIC resource, select a network adapter
for each node in the cluster.
The wizard lists the public network adapters along with the adapters that
were assigned a low priority.

5

Review the summary information and choose whether you want to bring the
notification resources online when VCS starts and click Configure.

6

Click Finish to exit the wizard.

Configuring Wide-Area Connector process for global clusters
Configure the Wide-Area Connector process only if you are configuring a disaster
recovery environment. The GCO option configures the wide-area connector (WAC)
process for global clusters. The WAC process is required for inter-cluster
communication. Configure the GCO Option using this wizard only if you are
configuring a Disaster Recovery (DR) environment and are not using the Disaster
Recovery wizard.
You can configure the GCO Option using the DR wizard. The Disaster Recovery
chapters in the application solutions guides discuss how to use the Disaster
Recovery wizard to configure the GCO option.
To configure the wide-area connector process for global clusters

1

On the GCO Network Selection panel, specify the network information and
then click Next.

33

34

Installing the VCS agents for SQL Server and configuring the cluster
Configuring the cluster using the Cluster Configuration Wizard

If the cluster has a ClusterService group configured, you can use the IP address
configured in the service group or configure a new IP address.
Do the following:
■

To specify an existing IP address, select Use existing IP resource and then
select the IP address from the drop-down list.

■

To use a new IP address, do the following:

■

■

In case of IPv4, select IPV4 and then enter the IP address and
associated subnet mask. Make sure that the specified IP address has
a DNS entry.

■

In case of IPv6, select IPV6 and select the IPv6 network from the
drop-down list.
The wizard uses the network prefix and automatically generates a
unique IPv6 address that is valid on the network.
The IPv6 option is disabled if the network does not support IPv6.

Select a network adapter for each node in the cluster.
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The wizard lists the public network adapters along with the adapters that
were assigned a low priority.

2

Review the summary information and choose whether you want to bring the
WAC resources online when VCS starts and then click Configure.

3

Click Finish to exit the wizard.
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Managing storage
This chapter includes the following topics:
■

Managing storage using NetApp filer

■

Managing storage using Windows Logical Disk Manager

Managing storage using NetApp filer
NetApp manages data by creating volumes on physical disks. These volumes can
further be divided into LUNs (Logical Unit Numbers). The LUNs are accessible
from the cluster nodes, provided the nodes have Microsoft iSCSI Initiator and
NetApp SnapDrive installed. However, if you plan to use Fibre Channel (FC) for
connecting the LUNs, ensure that filer is connected to the nodes and the LUNs
are shared between all the cluster nodes.
Refer to the NetApp documentation for more information.
Figure 3-1 illustrates a typical VCS cluster in a NetApp storage environment.
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Figure 3-1

VCS cluster in a NetApp storage environment

The VCS agent for Microsoft SQL requires two LUNs to be created on the NetApp
filer, one for SQL Server data and the other for the registry replication information.
If you plan to configure an MSDTC service group, create additional volumes for
MSDTC log and MSDTC registry replication. These LUNs must be accessible from
all cluster nodes.
Symantec recommends that you create separate LUNs (virtual disks) for the
following:
■

INST1_DATA_FILES
Contains the SQL Server system data files (including the master, model, msdb,
and tempdb databases).

■

INST1_REGREP_VOL
Contains the list of registry keys that must be replicated among cluster systems
for the SQL Service. Create a 100 MB (minimum recommended size) volume
for this purpose.

■

INST1_DB1_VOL
Contains the user database files.

■

INST1_DB1_LOG
Contains the user database log files.

These LUNs must be accessible from all cluster nodes.
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Perform the following tasks to create LUNs on the NetApp filer and to make them
accessible from cluster nodes:
■

Add the filer storage system to the SnapDrive Storage System Management
snap-in on the cluster nodes.

■

Create volumes on the NetApp filer.

■

Share the volumes.

■

Create LUNs or virtual disks on the shared volumes.
Refer to NetApp documentation for instructions on performing these tasks.

Connecting virtual disks to the cluster node
Once the virtual disks are created on the NetApp filer, they must be connected (if
not connected already) to the cluster nodes using NetApp SnapDrive.
To connect virtual disks to the cluster node

1

On the cluster node where you want to connect the LUN, click Start > All
Programs > Administrative Tools > Computer Management to start the
Computer Management MMC.

2

From the left pane, expand Storage and double-click SnapDrive.

3

Right-click Disks and then click Connect Disk to launch the Connect Disk
wizard.

4

Click Next on the Welcome page.

5

Specify the path of the virtual disk that you wish to connect to the cluster
node and then click Next.

6

Select Dedicated as the Virtual Disk Type and then click Next.

7

Click Assign a Drive Letter and then choose a drive letter from the drop-down
list.

8

On the Select Initiator panel, specify the initiator(s) for the virtual disk and
then click Next.

9

On the igroup Management Type panel, choose the option that allows
SnapDrive to perform igroup management automatically and then click Next.

10 Click Finish to begin connecting the specified virtual disk to the cluster node.

Disconnecting virtual disks from the cluster nodes
Perform the following steps to disconnect the virtual disks from a cluster node.
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To disconnect virtual disks

1

On the cluster node where you want to disconnect the LUNs, click Start > All
Programs > Administrative Tools > Computer Management to start the
Computer Management MMC.

2

From the left pane, expand Storage and double-click SnapDrive.

3

Double-click Disks to see the LUNs that are connected to the node.

4

Right-click the LUN you want to disconnect and then click Disconnect Disk.

5

In the Disconnect Disk alert box, click OK.

Managing storage using Windows Logical Disk
Manager
If your configuration uses shared disks and volumes that are managed using
Windows Logical Disk Manager (LDM), use the VCS Mount and DiskReservation
(DiskRes) agents. If you use LDM to manage non-shared local storage, use the VCS
Mount and NativeDisks agents.
Before configuring the storage, review the resource types and attribute definitions
of these VCS storage agents (Mount, DiskRes, NativeDisks) described in the Veritas
Cluster Server Bundled Agents Reference Guide.
The following restrictions apply for storage managed using LDM:
■

Mount, DiskRes, and NativeDisks agents are supported on VCS for Windows
only. These agents are not supported if the storage is managed using Storage
Foundation for Windows (SFW).

■

If you are using shared storage, your storage devices must be configured to
use SCSI-2 disk reservations. SCSI-3 is not supported.
SCSI support is not required if you are using non-shared storage.

■

LDM support is not applicable for Disaster Recovery configurations. Currently
only HA configurations are supported.

The VCS SQL Server agent requires that you create two volumes, one for SQL
Server data and the other for the registry replication information.
If you will plan to configure an MSDTC service group, create additional volumes
for MSDTC log and MSDTC registry replication.
Symantec recommends that you create separate volumes for the following:
■

INST1_DATA_FILES
Contains the SQL Server system data files (including the master, model, msdb,
and tempdb databases).
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■

INST1_REGREP_VOL
Contains the list of registry keys that must be replicated among cluster systems
for the SQL Service. Create a 100 MB (minimum recommended size) volume
for this purpose.

■

INST1_DB1_VOL
Contains the user database files.

■

INST1_DB1_LOG
Contains the user database log files.

If you are using a shared storage configuration, ensure that these volumes are
created on shared storage and are accessible from all cluster nodes.
If you are using a non-shared storage configuration, create these volumes
separately on the local storage attached to each cluster node.
Perform the following tasks to configure your storage:
■

Reserve disks
See “Reserving disks (if you use Windows LDM)” on page 41.

■

Create volumes
See “Creating volumes (if you use Windows LDM)” on page 42.

■

Mount volumes
See “Mounting volumes (if you use Windows LDM)” on page 42.

■

Unassign the drive letter
See “Unassigning a drive letter” on page 43.

■

Release the disks
See “Releasing disks (if you use Windows LDM)” on page 44.

Reserving disks (if you use Windows LDM)
Complete the following steps to reserve the disks on the node on which you are
going to perform the application installation.
These steps are required only if you are configuring shared storage. Skip these
steps for a non-shared storage configuration.
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To reserve the disks

1

To display all the disks, type the following on the command line:
C:\>havol -scsitest /l

Make a note of the disk numbers (Disk# column in the table). You will need
it in the next step.

2

To reserve a disk, type the following on the command line:
C:\>havol -scsitest /RES:<disk #>

For example, to reserve disk #4, type:
C:\>havol -scsitest /RES:4

Make a note of the disk number and the corresponding signature. You will
require these details to identify and reserve the disks during installation and
while configuring the service group, on additional nodes in the cluster.

Creating volumes (if you use Windows LDM)
Perform the following steps to create volumes.
To create volumes

1

Use the Windows Disk Management tool to verify that the disks are visible
on the cluster nodes, and then create volumes on the disks.

2

In case of shared storage, after creating the required volumes on a node,
release the reserved disks from that node.
See “Releasing disks (if you use Windows LDM)” on page 44.

3

3. In case of shared storage, rescan the disks on all the remaining nodes in
the cluster.
Refer to Microsoft Windows documentation for more information about the
Disk Management tool.

Mounting volumes (if you use Windows LDM)
Perform the following steps to mount volumes on a cluster node.
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To mount a volume

1

Use the Windows Disk Management tool to mount the volumes that you
created earlier.

2

After mounting the volumes on a cluster node, run the CHKDSK command
and verify that there are no errors on the mounted volumes.

3

Make a note of the drive letters that you assign to the mounted volumes.
Use the same drive letters while mounting these volumes on the remaining
cluster nodes.
Refer to Microsoft Windows documentation for more information about the
CHKDSK command and the Disk Management tool.

Unassigning a drive letter
In case of a shared storage configuration, while installing an application on
multiple nodes, you must first unassign drive letters and release the disks from
one node, and then reserve the disks, mount the volumes using the same drive
letters and then install the application on the failover node.
These steps are required only if you are configuring shared storage. Skip these
steps for a non-shared storage configuration.
Note: You must run Disk Management on all systems each time you add a shared
disk. This ensures each disk has a valid signature written to it, and that the device
paths and symbolic links are updated.
Complete these steps to unassign the drive letters from a node.
To unassign drive letter

1

Log in as Administrator.

2

Open Disk Management. Type the following at the command prompt:
C:\> diskmgmt.msc

3

Right-click the partition or logical drive and click Change Drive Letter and
Path.

4

In the Change Drive Letter and Paths dialog box, click the drive letter and
click Remove.

43

44

Managing storage
Managing storage using Windows Logical Disk Manager

Releasing disks (if you use Windows LDM)
Perform the following steps to release reserved disks from a cluster node.
These steps are required only if you are configuring shared storage. Skip these
steps for a non-shared storage configuration.
To release disks

1

To display all the disks, type the following on the command line:
C:\>havol -scsitest /l

Make a note of the disk numbers (Disk# column in the table) of the disk that
you wish to release. You will need it in the next step.

2

To release a reserved disk, type the following on the command line:
C:\>havol -scsitest /REL:<disk #>

For example, to release disk 4, type:
C:\>havol -scsitest /REL:4

Make a note of the disk number and the corresponding signature. You may
require these details to identify and reserve the disks later.
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Installing and configuring
SQL Server
This chapter includes the following topics:
■

About installing SQL Server for high availability configuration

■

Installing SQL Server 2005 on the first node

■

About installing SQL Server 2005 on the second node

■

Assigning ports for multiple SQL Server instances

■

Enabling IPv6 support for the SQL Server Analysis Service

About installing SQL Server for high availability
configuration
Consider the following points before installing SQL Server:
■

Verify that Microsoft Internet Information Services (IIS) is installed and
enabled on the system. Otherwise, you will be prompted to install or enable
IIS and then restart the installation.

■

If you are using the shared NetApp storage, ensure the following:
■

The Microsoft iSCSI Initiator is configured to establish a persistent
connection between the NetApp filer and the systems on which you want
to install and configure SQL Server.

■

The volumes are created on an external, basic disk, or LUNs (virtual disks)
on a NetApp filer. These disks must be mounted on or connect to the first
system on which you plan to install SQL Server.
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■

If you are using Windows LDM storage, ensure that the disks are accessible
from all the systems where you plan to install SQL Server.
Symantec recommends that you create volumes for the following:
■

SQL Server data

■

Registry replication

■

User defined database

■

User defined database logs

■

FILESTREAM enabled databse objects

■

Installing SQL Server on the first system
In case of shared storage, you must install the SQL instance on the local disk
and install the SQL database files and analysis service files on the shared
disk.The shared disks must be accessible from all the systems where you wish
to install and configure SQL Server.
In case of non-shared storage, you must install the database files on the disks
residing on a datastore that is accessible from all the systems where you want
to install and configure SQL Server. These disks are deported and imported
during a failover.

■

Installing SQL Server on additional systems
Irrespective of how the storage is configured (whether shared or non-shared),
install the SQL instances, database files and analysis service files on the local
disk.

■

If you are installing multiple instances of SQL Server on the same system,
ensure the following:
■

Assign a unique name and a unique instance ID to each SQL Server instance.
When installing SQL Server on additional systems for the same instance,
ensure that you specify the same instance name and ID.

■

The order of the instance installation does not matter. You must ensure
that the instances are installed with the same name and ID on all the
systems.

■

Assign a unique port number for each instance.

■

The logged-on user must be a domain user with local Administrator privileges.

■

The logged-on user must be a member of the local Administrators group on
all systems where you want to install Microsoft SQL Server.
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Configuring Microsoft iSCSI initiator
The Microsoft iSCSI initiator enables communication between Windows systems
and NetApp Filers. The initiator uses the iSCSI protocol to present the filer volume
as a local block device to the system.
To configure Microsoft iSCSI initiator on a Windows Server 2008 system

1

Start the Microsoft iSCSI initiator.

2

On the Discovery tab, click Add Portal.

3

On the Add Target Portal dialog box, specify the DNS name for the NetApp
filer and then click OK.

4

On the Targets tab, click Log On.

5

On the Log On to Target dialog box, clear the Automatically restore this
connection when the system reboots check box and then click OK.

6

On the Targets tab, verify that the newly added portal is listed under the
Select a target box and the status shows "connected". Click OK.

To configure Microsoft iSCSI initiator on a Windows Server 2008 R2 system

1

Start the Microsoft iSCSI initiator.

2

On the Discovery tab, click Discover Portal.

3

On the Discover Target Portal dialog box, specify the DNS name for the NetApp
filer and then click OK.

4

On the Target tab, click Connect.

5

On the Connect to Target dialog box, clear the Add this connection to list of
Favorite Targets check box and then click Ok.

6

On the Targets tab, verify that the newly added portal is listed under the
Select a target box and the status shows "connected". Click OK.

Installing SQL Server 2005 on the first node
Install Microsoft SQL Server 2005 on the first node using the SQL installation
wizard. In case of a shared storage configuration, install the SQL program files
to a local disk and the SQL data files to the shared storage. For a non-shared
storage configuration, install the SQL binaries and the SQL data files to the local
non-shared disks.
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Note: Only the portions of the SQL Server installation procedure relevant to the
VCS environment are documented. Refer to the Microsoft SQL Server 2005
documentation for detailed installation information.
To install Microsoft SQL Server 2005

1

Navigate to the installation directory and launch splash.hta.

2

Under the Install section, click Server components, tools, Books Online, and
samples.

3

Continue with the installation, following the instructions in the Microsoft
SQL Server 2005 Setup Wizard.
Complete the SQL Server Component Update, System Configuration Check,
and Registration Information panels.

4

In the Components to Install panel, select SQL Server Database Services and
Workstation Components and optionally select any of the other components
to install.
If you install optional components on one node, install the same components
in the same order on other nodes.

5

Click Advanced and in the Feature Selection panel, specify the path for SQL
Server data files and other selected services.
Set the data files to the shared storage managed by the cluster disk group, as
shown in the following:
■

Expand Database Services, click Data Files, and click Browse.
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■

In the Change Folder panel, set the installation path to the drive letter
and location of the volume that was created for the SQL Server system
data files (INST1_DATA_FILES). You can allow the rest of the path
(Program Files\Microsoft SQL Server) to remain and click OK.
You must set the same path on all nodes.
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6

In the Feature Selection panel, expand Client Components and ensure that
Connectivity Components and Management tools are selected. Click Next.

7

In the Instance Name panel, enter an instance name (for example, INST1)
and click Next.
Use the same instance name when you install this instance of SQL Server
2005 on failover nodes. If you are installing multiple instances of SQL in the
cluster, each instance must have a unique instance name.

8

In the Service Accounts panel, make the following selections and click :
■

Select Use a domain user account.
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9

■

Specify the user name, password, and domain.
If SQL Server services are not installed with a domain user account, the
SQL service group may fail to come online on the cluster nodes. It may
come online only on the node on which SQL Server was installed last. In
such a case, you must perform additional steps after configuring the SQL
service group.
See Technote: http://seer.entsupport.symantec.com/docs/281828.htm.

■

Clear all the check boxes that start services except for the SQL Browser,
so that the SQL Server is not brought online.

Follow the wizard instructions to complete the installation. Reboot if
prompted.

10 Install any SQL service packs or hotfixes if required.
11 From the Windows Services console, set the startup type of all SQL services,
except for the SQL Browser service, to Manual. Set the SQL Browser service
to Automatic.
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About installing SQL Server 2005 on the second node
Run the Microsoft SQL Server 2005 installer to install SQL Server 2005 on the
second or any additional cluster node.
Perform the following tasks before you install SQL Server 2005 on additional
nodes. These tasks must be performed for every node that is intended to be a part
of the cluster.
Table 4-1 lists the tasks you must perform before installing SQL Server 2005 on
additional nodes.
Table 4-1

Pre-install tasks for installing SQL Server 2005 on additonal nodes

Task

Description

Stop the SQL Server
2005 service

Stop a running SQL Server service on the configured node so the
databases on the shared disk can be manipulated by the installation
on the second node.

(for shared storage
configuration only)

Disconnect virtual
disks from the first
node

To stop the SQL Server service
1

Start the SQL Server Configuration
Manager.(Start>AllPrograms>Microsoft SQL Server 2005 >
Configuration Tools > SQL Configuration Manager).

2

In the left pane, click SQL Server 2005 Services.

3

In the right pane, right-click the SQL Server instance and select
Stop.

4

Repeat for all other SQL Server services that are running on
the server.

5

Exit the SQL Server Configuration Manager.

See “Disconnecting virtual disks from the cluster nodes” on page 39.

(for shared storage
configuration only)
Release disks from
the first node
(applicable only if
you use Windows
LDM)
(for shared storage
configuration only)

See “Unassigning a drive letter” on page 43.
See “Releasing disks (if you use Windows LDM)” on page 44.
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Table 4-1

Pre-install tasks for installing SQL Server 2005 on additonal nodes
(continued)

Task

Description

Connect virtual disks See “Connecting virtual disks to the cluster node” on page 39.
to the second node
(for shared storage
configuration only)
Mount volumes on
the second node
(applicable only if
you use Windows
LDM)

See “Creating volumes (if you use Windows LDM)” on page 42.

Rename SQL Server
2005 shared files

Before installing SQL on the second node, open the SQL Server
system data files volume (INST1_DATA_FILES) and rename or
remove the first node SQL Server system data files. The files will
be replaced during the installation of SQL Server on the additional
nodes.

(for shared storage
configuration only)

If you rename the folder that contains the system data files, the
files are available as backup files in case problems occur during the
second node SQL Server installation. Once the installation
completes successfully, you can then delete the renamed folder and
its contents.

To rename shared SQL Server data files

General tasks

1

On the computer on which the cluster disk group is imported,
open the volume that holds the SQL Server data files.

2

Rename the folder that contains the SQL Server data files.

Ensure that you follow the below guidelines, during the SQL Server
installation:
In case of shared storage, install the SQL instance to a local disk
and the SQL database files to the shared storage managed by
the cluster disk group. For non-shared storage, install the SQL
instance and SQL database files on non-shared local disks.
■ Use the same instance name and instance ID that you used while
installing the instance on the first cluster node.
■ Select all the desired features (for example, Full-Text Search,
Analysis Services) that you wish to configure.
■
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Assigning ports for multiple SQL Server instances
If you are running multiple SQL Server instances, you must assign a different
port to each named instance. You can assign static or dynamic ports.
Refer to the Microsoft Knowledge Base for the instructions on assigning ports.
At the time of this release, this information is in the following article:
Microsoft Knowledge Base Article - 823938: How to configure an instance of SQL
Server to listen on a specific TCP port or a dynamic port
See Technote: http://support.microsoft.com/kb/823938/en-us.
If you wish to change the port after configuring the SQL service group, you must
perform the steps in the following order:
■

Bring the SQL service group online or partially online (upto the registry
replication resource) on a cluster node.

■

On the node on which the SQL service group is online or partially online,
change the port assigned to the SQL instance. Refer to the instructions
mentioned in the Microsoft Knowledge Base article specified earlier.

■

Take the SQL service group offline on the node, and then bring it online again.
The configuration changes will be replicated to the remaining cluster nodes.

Enabling IPv6 support for the SQL Server Analysis
Service
This is applicable only if SQL Server is configured in an IPv6 network environment.
The SQL Analysis Services server properties, IPv4 Support and IPv6 Support,
determine which protocol is used by the Analysis Server. You must manually
modify these properties to enable IPv6 support for Analysis Service.
These steps are required only if you have configured named SQL Server instances.
Perform the following steps for each named SQL Server instance. Repeat these
steps on all the cluster nodes that will host the SQL service group.
To enable IPv6 support for SQL Server Analysis Service

1

Start the Analysis Service.

2

Open SQL Server Management Studio and connect to the Analysis Server.

3

In the Object Explorer pane, right-click the server to which you have connected
and click Properties.

4

On the General page, check the Show Advanced (All) Properties check box.
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5

Locate Network \ Listener \ IPV4Support property and in the Value field type
0.
This means that IPv4 is disabled. Analysis Server does not listen on the IPv4
port, and clients will not be able to connect using IPv4.

6

Locate Network \ Listener \ IPV6Support property and in the Value field type
2.
This means that IPv6 is optional. The Analysis Server tries to listen on the
IPv6 port, but will silently ignore errors and continue to start if IPv6 is not
available.

7

Click OK to save the changes.

8

Stop the Analysis Service.

9

Perform these steps for each named instance and on all the cluster nodes
where SQL Server is installed.
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Chapter

5

Configuring the SQL service
group
This chapter includes the following topics:
■

About configuring the SQL service group

■

Before configuring the SQL service group

■

Configuring a SQL Server service group using the wizard

■

Running SnapManager for SQL

■

Making SQL Server user-defined databases highly available

■

Verifying the service group configuration

■

Administering a SQL Server service group

About configuring the SQL service group
Configuring the SQL Server service group involves creating VCS resources for the
SQL agents, storage agents (NetApp, LDM) and network agents. VCS provides
several ways of configuring a service group, which include the service group
configuration wizard, Cluster Manager (Java Console), and the command line.
This chapter provides instructions on configuring a SQL service group using the
SQL Server Configuration Wizard.
A SQL service group is used to bring a SQL Server instance online on another node
if the active node fails. If you have set up multiple cluster nodes, you specify the
priority of the failover node while configuring the service group. The SQL Server
Configuration Wizard enables you to create a SQL Server service group and define
the attributes for its resources on all the nodes within the cluster simultaneously.
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For a shared storage configuration, use the service group configuration wizard
to configure the service group.

Before configuring the SQL service group
Ensure the following before configuring the SQL service group:
■

Verify that VCS, along with the VCS database agent for SQL Server, is installed
on all the cluster nodes.

■

Verify that you have configured a VCS cluster using VCS Cluster Configuration
Wizard (VCW).

■

Verify that SQL Server is identically installed on all the cluster nodes that will
participate in the service group.

■

Verify that you have VCS Administrator privileges. This user classification is
required to create and configure a service group.

■

The logged-on user account must be a local Administrator on the node where
you run the wizard. If you wish to configure detail monitoring for a SQL
instance, the logged-on user must have the permission to log on to that SQL
instance.

■

You must be an Administrator for the NetApp filer containing the LUNs created
to store SQL Server components.

■

Verify that the Veritas High Availability Engine (HAD) is running on the system
from where you run the wizard.

■

Verify that the volumes or LUNs (virtual disks) created to store the following
data components are mounted or connected to the node where you run the
wizard and dismounted or disconnected from other nodes in the cluster:
■

SQL Server system data files

■

Registry replication information.

■

User database files

■

User database log files

■

In case of IPv4, assign a unique virtual IPv4 address to the SQL Server instance.
You specify this IP address when configuring the service group.
In case of IPv6, the configuration wizard automatically generates an IPv6
address based on the network selected. The IPv6 address is valid and unique
on the network.

■

In an IPv6 environment, the Lanman agent relies on the DNS records to validate
the virtual server name on the network. If the virtual servers configured in
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the cluster use IPv6 addresses, you must specify the DNS server IP, either in
the network adapter settings or in the Lanman agent’s AdditionalDNSServers
attribute.
■

If you wish to use a script for detail monitoring, either save the script file in
shared storage or ensure that the same file exists in the same location on all
the cluster nodes.
A sample SQL script is located at
%VCS_HOME%\bin\SQLServer2005\sample_script.sql. Where, %VCS_HOME%
is the product installation directory for VCS, typically
C:\Program Files\Veritas\Cluster Server

If the script is successfully executed during monitoring, the agent considers
the database instance available. If the execution fails, the database instance
is considered not available and the service group faults and fails over to the
failover nodes. You can customize the script to meet your configuration
requirements.
Note: You should use a separate script for each SQL Server service group that
exists in the cluster. The script should exist on all the nodes in the service
group.

■

Review the resource types and the attribute definitions of the agents.

■

If you have configured Windows Firewall, add the following to the Firewall
Exceptions list:
■

Port 14150 or the VCS Command Server service,
%vcs_home%\bin\CmdServer.exe.
Here, %vcs_home% is the installation directory for VCS, typically
C:\Program Files\Veritas\Cluster Server.

■

Port 14141

For a detailed list of services and ports used by VCS, refer to the Veritas Cluster
Server for Windows Installation and Upgrade Guide.

Configuring a SQL Server service group using the
wizard
This section describes how to configure a SQL service group using the configuration
wizard.
For a shared storage configuration, use the service group configuration wizard
to configure the service group.
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To create a SQL Server service group on the cluster

1

Ensure that you have stopped the SQL Server service for the instance and
are running the wizard from the first cluster node.

2

Start the SQL Configuration Wizard from the Solutions Configuration Center
or click Start > All Programs > Symantec > Veritas Cluster Server >
Configuration Tools > SQL Server Configuration Wizard.

3

Review the prerequisites on the Welcome panel and then click Next.

4

On the Options panel, select Create service group and then click Next.

5

On the Service Group Configuration panel, specify the service group name
and system list.
Complete the following:
■

In the Service Group Name field, specify a name for the SQL Server service
group, for example, INST1_SG. If there are multiple instances, ensure that
the name is unique within the cluster.

■

In the Available Cluster Systems box, select the systems on which to
configure the service group and click the right-arrow to move the systems
to the Systems in Priority Order list.

■

To change the priority of a system in the Systems in Priority Order list,
select the system and click the up and down arrow icons. Arrange the
systems in priority order as failover targets for the group. The server that
needs to come online first must be at the top of the list.
For an active/active configuration, ensure that the active and failover
systems are set differently for each instance. For example, if the system
priority for the first instance is SYSTEM1, then SYSTEM2, the system
priority for the second instance should be SYSTEM2, then SYSTEM1.

■

To enable the service group to automatically come online on one of the
systems, select the Include selected systems in the service group's
AutoStartList attribute checkbox.
For information about the AutoStartList attribute, see the Veritas Cluster
Server Administrator's Guide.

■

Click Next.
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6

On the SQL Server Instance Selection panel, select the SQL Server instance
and any other services that were installed and that needs to be configured
for high availability in your environment and then click Next.
Clear the Configure NetApp SnapMirror Resource(s) check box. This option
is applicable only in case of a disaster recovery configuration. The SnapMirror
resource is used to monitor replication between filers at the primary and the
secondary site, in a disaster recovery configuration. If you are setting up a
disaster recovery environment, check this check box to configure the
SnapMirror resource at the primary site. Note that you must configure the
SnapMirror resource only after you have configured the cluster at the
secondary site.

7

On the User Databases List panel, view the summary of the databases for the
selected instance and then click Next.
In case of multiple instances, select the required instance from the SQL
Instance dropdown list. The panel displays the databases and the respective
files for which the wizard configures resources. Click a database name to view
its database files.
Databases that appear with a red cross indicate that the wizard does not
configure the storage agent resources for those items. These databases either
do not reside on shared storage or the wizard is unable to locate them. If you
wish to configure resources for these databases, ensure that the database are
located on shared storage and then run the wizard again.

8

On the Detail Monitoring Configuration panel, configure detail monitoring
for the SQL server instances. This step is optional. If you do not want to
configure detail monitoring, click Next and proceed to the next step.
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Perform the following steps if you wish to configure detail monitoring for an
instance:
■

Select the check box for the SQL Server instance for which you want to
configure detail monitoring. Only the instances selected on the SQL
Instance Selection panel in the earlier step are available for selection.

■

Specify the domain user name and password for connecting to SQL Server
database. Make sure the specified user has SQL Server log on permissions.
The user name must be the Fully Qualified Domain Name (FQDN) in the
format domain.com\user name.

■

If the path of the script is same on all nodes, choose the Global option,
click the SQL Monitor Script text box, and specify the path to the script
on the first system displayed in the System Name list. If the path of the
script is different on all nodes, choose the Per System option, and specify
the path for the script on each node. Make sure the specified path exists
on all the systems in the cluster.

■

Select the Fail over service group if detail monitoring script execution
fails checkbox, if not already selected. This will enable the SQL agent to
fail over the service group if the detail monitoring script execution fails.

■

Click Apply.
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9

On the Registry Replication Path panel, specify the mount path to the registry
replication volume (INST1_REGREP_VOL) and click Next.
Symantec recommends that RegRep resources and SQL data be in separate
volumes.

10 On the Virtual Server Configuration panel, configure the virtual server as
follows:
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■

■

Select IPv4 to configure an IPv4 address for the virtual server.
■

In the Virtual IP Address field, type a unique virtual IPv4 address that
is currently not being used on your network, but is in the same subnet
as the current node.

■

In the Subnet Mask field, type the subnet to which the virtual IPv4
address belongs.

Select IPv6 to configure an IPv6 address for the virtual server. The IPv6
option is disabled if the network does not support IPv6.
■

Select the network from the drop-down list. The wizard uses the
network prefix and automatically generates an IPv6 address that is
valid and unique on the network.

■

Enter the virtual name for the server, for example INST1-VS. Ensure that
the virtual server name you enter is unique in the cluster.

■

For each system in the cluster, select the public network adapter name.
The Adapter Display Name field displays the TCP/IP enabled adapters on
a system, including the private network adapters, if they are TCP/IP
enabled. Make sure that you select the adapters to be assigned to the public
network, and not those assigned to the private network.
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■

If you require a computer object to be created in the Active Directory,
click Advanced Settings, check the Active Directory Update required
check box, specify the desired Organizational Unit (OU) in the domain
and then click OK.
This sets the Lanman resource attributes ADUpdateRequired and
ADCriticalForOnline to true. It allows the Lanman agent to update the
Active Directory with the virtual server name.
You can type the OU details in the format
CN=Computers,DC=domainname,DC=com. To search for an OU, click
on the ellipsis button and specify the search criteria in the Windows Find
Organization Unit dialog box.
By default, the Lanman resource adds the virtual server to the default
container “Computers.” The user account for VCS Helper service must
have adequate privileges on the specified container to create and update
computer accounts.

■

Click Next.

11 On the Initiator Selection panel, select the initiator for the virtual disk from
the list of available initiators displayed for each cluster node, and then click
Next.
If you are configuring MPIO over FC, you must select at least 2 FC initiators
for each cluster node. Note that the node from which you run this wizard
already has an initiator selected by default. This is the initiator that was
specified when you connected the LUNs to this cluster node.

12 On the Service Group Summary panel, review the service group configuration
and then click Next. The Resources box lists the configured resources. The
wizard assigns unique names to resources based on their respective name
rules. Click a resource to view its attributes and their configured values in
the Attributes box. Optionally, if desired, change the names of the resources.
To edit a resource name, click the resource name or press the F2 key. Press
Enter after editing each resource name.
To cancel editing a resource name, press Esc.
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13 Click Yes when prompted to confirm creating the service group. Messages
indicate the status of the commands.

14 Select the Bring the service group online check box, if you want to bring the
service group online.
You may want to review the service group configuration in the Cluster
Manager (Java Console) before bringing the service group online. You can use
the Cluster Manager to bring the service group online later.
You must bring the SQL service group online on the node from where you
ran the configuration wizard. This is the first cluster node where you installed
SQL Server. This allows the wizard to configure the resources required for
SQL Server services.
The wizard marks all the resources in the service group as CRITICAL. If
desired, use Cluster Manager (Java Console) or the command line to change
the state.
If you have created a new SQL Server database, you must modify the SQL
Server service group to add the required storage agent resources to the service
group. Run the service group configuration wizard to modify the service
group.
Click Finish to exit the wizard or click Next to configure another SQL service
group or an MSDTC service group.
The wizard marks all the resources in the service group as CRITICAL. If
desired, use Cluster Manager (Java Console) or the command line to change
the state.
You can also configure an MSDTC service group.
To configure detail monitoring for a SQL Server instance

1

On the Detail Monitor configuration dialog box, specify the monitoring
frequency in the Detail monitoring interval field.
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This sets the value for the LevelTwoMonitorFreq attribute of the SQL agent.
It indicates the number of online monitor cycles that the agent must wait
before performing detail monitoring. The default value is 5. Symantec
recommends that you set the monitoring interval between 1 and 12.

2

■

Select DBList Detail Monitoring and then choose the databases from the
list of databases available for the instance. The selected databases populate
the DBList attribute of the SQL agent. In this mode of detail monitoring
the agent monitors the health of the databases by connecting to those
databases. The agent monitors only the databases specified in the DBList
attribute.

■

Select SQL-Script based detail monitoring if you wish to use a script to
monitor SQL server databases. In this mode of detail monitoring, the agent
executes the script that you specify for detail monitoring.

Specify the fully qualified user name and the password for connecting to the
SQL Server database. Make sure that the user has SQL Server logon
permissions.
Note: These credentials are required for both, DBList as well as SQLFile detail
monitoring.
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3

Select Global or Per System depending on whether the monitoring script
location is the same for all the nodes or is unique for each cluster node, and
then specify the path of the script appropriately.

4

Check Fail over service group if detail monitoring fails check box, if not
already checked. This allows the SQL agent to fail over the service group to
another node if the detail monitoring fails.

5

Click Apply.

Running SnapManager for SQL
After configuring the service group, you may want to run the SnapManager
Configuration Wizard on the node on which the service group is online, to schedule
backups of SQL Server database.
You must adhere to the following requirements while running SnapManager for
SQL:
■

Make sure the SQL service group is online.

■

Do not move the SQL Server database components.

If you are scheduling backups in a VCS cluster, schedule them on the node on
which the service group is online. If the SQL service group fails over to another
node, you must set up the backup schedule again on the new node.
See the NetApp documentation for more information about running SnapManager
for SQL.

Making SQL Server user-defined databases highly
available
You can use VCS to manage user-defined SQL Server databases. Create the required
SQL databases using the SQL Server Management Studio and then make them
highly available with VCS.
Perform the following tasks to configure user-defined databases with VCS:
■

Create volumes or LUNs for a user-defined SQL Server database and its
transaction log.

■

Create a SQL Server user-defined database and point the database files and
transaction log to the paths of the new volumes or LUNs.

■

Modify the SQL service group using the SQL Server Configuration Wizard to
add the NetAppFiler and NetAppSnapDrive resources for the user databases.
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Create volumes or LUNs for SQL user-defined databases
You must create volumes or LUNs for a user-defined SQL Server database and its
transaction log.
In the sample deployment these volumes are named as follows:
■

INST1_DB1_VOL
Contains a user-defined database file

■

INST1_DB1_LOG
Contains a user-defined database log file

Creating SQL Server databases
Use the SQL Server Management Studio to create a SQL Server user-defined
database for the required SQL instance. While creating the database, ensure that
you point the database files and transaction log to the paths of the new volumes
or LUNs created earlier.
To create a new SQL Server 2005 database

1

Open SQL Server Database Manager (Start > All Programs > Microsoft SQL
Server 2005 > SQL Server Management Studio).

2

Expand the icon associated with your server.

3

Right-click on Databases and then click New Database.

4

In the New Database page, type a name for the new database.

5

Click ... (ellipsis button) in the Path column, browse to the location of the
volume where you want to create your user database, and click OK.

6

Select and edit other file properties as desired.

7

Click ... (ellipsis button) in the Path column for the Transaction Log row and
browse to the location of the volume you want to create for the transaction
log, and click OK.

8

To add more data files if required, do the following:

9

■

Select Add.

■

Edit the properties in the new data file rows as required.

Click OK.

Adding storage agent resources to the SQL service group
After creating the database, run the SQL Server Agent Configuration Wizard and
modify the SQL Server service group. This allows the wizard to add the NetAppFiler
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and NetAppSnapDrive (Mount and DiskRes in case of Windows LDM) storage
resources for the user databases, to the SQL Server service group.
For a shared storage configuration, use the service group configuration wizard
to modify the service group. For a non-shared storage configuration, use the
Cluster Manager (Java Console) to add the required storage resources to the service
group manually.
Note: You must run the wizard in the modify mode even if you have added or
changed volumes in your existing configuration.
Before running the configuration wizard to add the storage agent resources, do
the following:
■

Make sure the SQL service group is online.

■

Make sure the volumes for the user database and transaction logs are mounted
on the node.

Note: Mount or NetAppSnapDrive resources are required only if the database is
created on a new volume.
To add storage agent resources to the SQL service group

1

Start the SQL Server Configuration Wizard from the Solutions Configuration
Center or click Start > All Programs > Symantec > Veritas Cluster Server >
Configuration Tools > SQL Server Configuration Wizard.

2

Select the MS-SQL Server Service Group Configuration, select the Edit
option, and click Next.

3

Review the Prerequisites page and click Next.

4

On the Wizard Options panel, click Edit service group, select the service
group and then click Next.

5

Click Yes on the VCS Notice informing you that the service is not completely
offline. No adverse consequences are implied.

6

In the Service Group Configuration page, click Next.

7

In the SQL Server Instance Selection page, make sure the correct instance of
SQL Server is selected and click Next.

8

In the User Databases List page, make sure the databases are shown with
correct paths and click Next.

9

If a database is not configured correctly, a VCS warning appears indicating
potential problems. Click OK to continue.
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10 In the Detail Monitoring and succeeding pages, review the information and
click Next to continue.

11 Click Yes to continue when a VCS Notice indicates the configuration will be
modified.

12 Click Finish to exit the wizard.
The wizard marks all the resources in the service group as CRITICAL. If
desired, use Cluster Manager (Java Console) or the command line to change
the state.

Verifying the service group configuration
Failover simulation is an important part of configuration testing. This section
provides steps to verify the SQL Server service group configuration by bringing
the service group online, taking the service group offline, and switching the service
group to another cluster node.

Bringing the service group online
Perform the following steps to bring the service group online from the VCS Java
or Web Console.
To bring a service group online from the Java Console

1

In the Cluster Explorer configuration tree, select the SQL service group to be
taken online.

2

Right-click the service group name, and select Enable Resources. This enables
all resources in the service group.

3

Right-click the service group name, and select the system on which to enable
the service group. (Right-click > Enable > system_name or Right-click > Enable
> All)

4

Save your configuration (File > Close Configuration).

5

Right-click the service group and select to online the service group on the
system. (Right-click > Online > system_name)

Taking the service group offline
Perform the following steps to take the service group offline from the VCS Java
or Web Console.
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To take a service group offline from the Java Console

1

On the Service Groups tab of the Cluster Explorer configuration tree,
right-click the service group.
or
Select the cluster in the Cluster Explorer configuration tree, select the Service
Groups tab, and right-click the service group icon in the view panel.

2

Choose Offline, and choose the appropriate system from the pop-up menu.
(Right-click > Offline > system_name)

Switching the service group
To verify the configuration of a cluster, either move the online groups, or shut
down an active cluster node, as follows:
■

Use Veritas Cluster Manager (Java Console) to switch all the service groups
from one node to another.

■

Simulate a local cluster failover by shutting down an active cluster node.

To switch service groups

1

In the Veritas Cluster Manager (Java Console), click the cluster in the
configuration tree, click the Service Groups tab, and right-click the service
group icon in the view panel. Then do the following:
■

Click Switch To, and click the appropriate node from the menu.

■

In the dialog box, click Yes. The service group you selected is taken offline
on the original node and brought online on the node you selected.
If there is more than one service group, you must repeat this step until
all the service groups are switched.

2

Verify that the service group is online on the node you selected to switch to
in the earlier step.

3

To move all the resources back to the original node, repeat step 1 for each of
the service groups.

To shut down an active cluster node

1

Gracefully shut down or restart the cluster node where the service group is
online.

2

In the Veritas Cluster Manager (Java Console) on another node, connect to
the cluster.
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3

Verify that the service group has failed over successfully, and is online on
the next node in the system list.

4

If you need to move all the service groups back to the original node, do the
following:
■

Restart the node you shut down in step 1.

■

Click Switch To, and click the appropriate node from the menu.

■

In the dialog box, click Yes.
The service group you selected is taken offline and brought online on the
node that you selected.

Administering a SQL Server service group
You can dynamically modify the SQL service group configuration in several ways,
including the SQL Server Configuration Wizard, Cluster Manager (Java Console),
Cluster Manager (Web Console), and the command line. The following steps
describe how to modify the service group using the SQL Server Configuration
Wizard.

Modifying a SQL service group configuration
Note the following prerequisites before modifying the SQL service group:
■

If the SQL Server service group is online, you must run the wizard from a node
on which the service group is online. You can then use the wizard to add
resources to and remove them from the configuration. You cannot change
resource attributes.

■

To change the resource attributes, you must take the service group offline.
However, the NetAppFiler and NetAppSnapDrive resources for the service
group should be online on the node where you run the wizard and offline on
all other nodes.

■

If you are running the wizard to remove a node from the service group’s system
list, do not run the wizard on the node being removed.

■

If you are running the wizard to add or remove NetAppSnapDrive resources
for user defined databases, make sure the service group is online.
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To modify a SQL Server service group

1

Start the SQL Server Configuration Wizard. Click Start > All Programs >
Symantec > Veritas Cluster Server > Configuration Tools > SQL Server
Configuration Wizard.

2

In the Select Configuration Option panel, click MS SQL Server - Service Group
Configuration, click Edit, and then click Next.

3

Review the prerequisites and click Next.

4

In the Service Group Selection panel, select the service group to modify and
click Next.

5

In the Service Group Configuration panel, perform the following actions as
necessary:
■

Add or remove systems from the service group’s system list.

■

Change the priorty order of the system list.

■

To add (or remove) the selected systems from the service group's
AutoStartList attribute, select (or deselect) the Include selected systems
in the service group's AutoStartList attribute checkbox.
For information about the AutoStartList attribute, see the Veritas Cluster
Server Administrator's Guide.

click Next.

6

In the SQL Server Instance Selection panel, select the SQL Server instance
to be made highly available and click Next.

7

In the User Databases List panel, verify the master and user defined databases
configured for the SQL instance. The wizard will create NetAppSnapDrive
resource for each database. Click Next.

8

Follow the wizard instructions and make desired modifications to the service
group configuration.

Deleting a SQL service group
The following steps describe how to delete a SQL Server service group using the
configuration wizard.
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To delete a SQL Server service group

1

Start the SQL Server Configuration Wizard. Click Start > All Programs >
Symantec > Veritas Cluster Server > Configuration Tools > SQL Server
Configuration Wizard.

2

In the Select Configuration Option dialog box, choose the MS-SQL Server Service Group Configuration option, choose the Delete option, and click
Next.

3

Review the prerequisites and click Next.

4

In the Service Group Selection dialog box, select the service group to delete
and click Next.

5

In the Service Group Summary dialog box, click Next.

6

A message appears informing you that the wizard will run commands to
delete the service group. Click Yes to delete the service group.

7

Click Finish.
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Chapter

6

Configuring an MSDTC
service group for high
availability
This chapter includes the following topics:
■

About configuring the MSDTC service group

■

Typical MSDTC service group configuration using shared storage

■

Before configuring the MSDTC service group

■

Creating an MSDTC service group

■

About configuring an MSDTC client

■

Configuring an MSDTC client

■

Verifying the installation

About configuring the MSDTC service group
Microsoft Distributed Transaction Coordinator (MSDTC) service enables you to
perform distributed transactions. A distributed transaction updates data on more
than one computer in a network. The MSDTC service ensures that a transaction
is successfully committed on each computer. A failure to commit on a single
system aborts the transaction on all systems in the network. If a transaction spans
across more than one computer in the network, you must ensure that the MSDTC
service is running on all the computers. Also, all the computers must be able to
communicate with each other.
Configuring the MSDTC service group involves the following tasks:
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■

Creating an MSDTC Server service group using the SQL Configuration Wizard

■

Configuring the MSDTC client manually

VCS provides several ways to configure a service group, including the service
group configuration wizard, Cluster Manager (Java Console), and the command
line. This chapter provides instructions on how to use the configuration wizard
to configure the MSDTC service group.

Typical MSDTC service group configuration using
shared storage
MSDTC servers can co-exist with SQL servers on the same cluster nodes. If the
MSDTC Server and the SQL Server are running on the same node, the MSDTC
client is configured in the default configuration. If the MSDTC Server is not
configured on the same node as the SQL Server, then the MSDTC client must be
configured on that node. In general, you must configure the MSDTC client on all
nodes except the node on which the MSDTC Server is configured to fail over. The
MSDTC client and the MSDTC Server must not run on the same cluster node.
For example, a SQL Server configuration in a VCS cluster might span four nodes
and two sets of shared storage.
The following configurations are possible:
■

MSDTC Server and SQL Server are configured on different nodes in the same
cluster

■

MSDTC Server and SQL Server are configured on the same nodes in a cluster

■

MSDTC Server and SQL Server are configured on nodes in different clusters
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Figure 6-1

MSDTC Server and SQL Server configured on different nodes

Figure 6-2

MSDTC Server configured on the same node as SQL Server
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Figure 6-3

MSDTC Server and SQL Server configured on nodes in different
clusters

Before configuring the MSDTC service group
Note the following prerequisites before you configure the MSDTC service group:
■

You must be a Cluster Administrator. This user classification is required to
create and configure a service group.

■

You must be a local Administrator on the node where you run the wizard.

■

Verify that the VCS agent for SQL Server is installed on all cluster nodes.

■

Verify that the VCS cluster is configured using the VCS Cluster Configuration
Wizard (VCW).

■

Verify that the MSDTC service is installed on all nodes that will participate in
the MSDTC Server service group.

■

Verify that the Distributed Transaction Coordinator (MSDTC) service is stopped.

■

Verify that you have created the volumes or LUNs (virtual disks) for storing
MSDTC log and MSDTC registry replication information.
See “Managing storage using NetApp filer ” on page 37.
See “Managing storage using Windows Logical Disk Manager ” on page 40.

■

Verify that the volumes or LUNs created for the MSDTC logs and registry
replication information are mounted or connected to the node where you run
the wizard. In case of a shared storage configuration, ensure that they are
dismounted or disconnected from all other nodes.
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■

If you have configured a firewall, add the following to the firewall exceptions
list:
■

Port 14150 or the VCS Command Server service,
%vcs_home%\bin\CmdServer.exe.
Here, %vcs_home% is the installation directory for VCS, typically
C:\Program Files\Veritas\Cluster Server.

■

Port 14141

For a detailed list of services and ports used by VCS, refer to the Veritas Cluster
Server Installation and Upgrade Guide.
■

Keep the following information ready with you; the wizard prompts you for
these details:
■

A unique virtual name for the MSDTC Server. This is the name that is used
by MSDTC clients to connect to the MSDTC Server. The DTC service runs
under this virtual name.

■

A unique virtual IP address for the for the MSDTC Server.
The virtual IP address is required only if you wish to configure an IPv4
address. In case of IPv6, the wizard prompts you to select the IPv6 network
and automatically generates an IPv6 address that is valid and unique on
the network. The wizard uses the prefix that is advertised by the router on
the IPv6 network.

Creating an MSDTC service group
MSDTC is a global resource and is accessed by more than one SQL Server service
group. Symantec recommends configuring one MSDTC service group in per cluster.
VCS provides a SQL Server Configuration Wizard that guides you through the
process of configuring an MSDTC service group. You can also use this wizard to
modify an MSDTC service group configuration.
Note: Symantec recommends that you create only one MSDTC Server service
group in a cluster.
This section describes the steps required to create an MSDTC Server service group
using the SQL Configuration Wizard.
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To create an MSDTC service group

1

Start the SQL Server Configuration Wizard. Click Start > All Programs >
Symantec > Veritas Cluster Server > Configuration Tools > SQL Server
Configuration Wizard.

2

In the Select Configuration Option panel, click MSDTC Server - Service Group
Configuration, click Create, and then click Next.

3

Review and verify that you have met the prerequisites for configuring an
MSDTC Server service group and then click Next.

4

On the Service Group Configuration panel, specify the service group name
and select the systems for the service group as follows:

5

■

Type a name for MSDTC service group.

■

In the Available Cluster Systems box, select the systems on which to
configure the service group and click the right-arrow to move the systems
to the Systems in Priority Order box. The systems listed in the Systems
in Priority Order box represent the SystemList attribute of the service
group. While selecting systems, make sure to select the systems that are
not in the SystemList attribute for an Exchange service group configured
in the cluster.
To remove a system from the service group’s system list, select the Systems
in Priority Order list and click the left arrow.
To change a system’s priority in the service group’s system list, select the
system from the Systems in Priority Order and click the up and down
arrows. The system at the top of the list has the highest priority while the
system at the bottom of the list has the lowest priority.

■

To enable the service group to automatically come online on one of the
systems, select the Include selected systems in the service group's
AutoStartList attribute checkbox.
For information about the AutoStartList attribute, see the Veritas Cluster
Server Administrator's Guide.

■

Click Next. If the cluster configuration is in read-only mode, the wizard
prompts you before changing it to read-write mode. The wizard starts
validating your configuration. Various messages indicate the validation
status.

On the Virtual Server Configuration panel, specify the information related
to the virtual server as follows:
■

Type a virtual name for the MSDTC Server. This is the name that is used
by MSDTC clients to connect to the MSDTC Server. The DTC service runs
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under this virtual name. Ensure that the virtual server name is unique in
the cluster.
■

■

Select IPv4 to configure an IPv4 address for the virtual server.
■

In the Virtual IP Address field, type a unique virtual IPv4 address for
the MSDTC server.

■

In the Subnet Mask field, type the subnet to which the virtual IPv4
address belongs.

Select IPv6 to configure an IPv6 address for the virtual server. The IPv6
option is disabled if the network does not support IPv6.
■

Select the network from the drop-down list. The wizard uses the
network prefix and automatically generates an IPv6 address that is
valid and unique on the network.

■

For each system, select the public network adapter name. The Adapter
Display Name field displays the TCP/IP enabled adapters on a system,
including the private network adapters, if they are TCP/IP enabled. To
view the adapters associated with a system, click the Adapter Display
Name field and then click the arrow. Make sure that you select the adapters
assigned to the public network, not the private.

■

Click Advanced Settings to configure the Lanman agent to perform
Windows Active Directory (AD) update. These settings are applicable to
the Lanman resource in the service group. On the Lanman Advanced
Configuration dialog box, complete the following:

■

■

Check the Active Directory Update required check box to enable the
Lanman agent to update the Active Directory with the virtual name.
This sets the Lanman agent attributes ADUpdateRequired and
ADCriticalForOnline to true.

■

In the Organizational Unit field, type the distinguished name of the
Organizational Unit for the virtual server in the format
CN=containername,DC=domainname,DC=com. To browse for an OU,
click the ellipsis (...) button and search for the OU using the Windows
Find Organization Units dialog box. By default, the Lanman resource
adds the virtual server to the default container "Computers."

■

Click OK.
The user account for VCS Helper service must have adequate privileges
on the specified container to create and update computer accounts.

Click Next.
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6

On the Specify Data Path panel, specify the drive letter for the MSDTC log
and registry replication directory and click Next. If the directory does not
exist, the wizard creates it. Symantec recommends using different paths for
these directories.
Clear the Configure NetApp SnapMirror Resource(s) check box. This option
is applicable only in case of a disaster recovery configuration. The SnapMirror
resource is used to monitor replication between filers at the primary and the
secondary site, in a disaster recovery configuration. If you are setting up a
disaster recovery environment, check this check box to configure the
SnapMirror resource at the primary site. The SnapMirror resource must be
configured only after you have configured the cluster at the secondary site.

7

On the Initiator Selection panel, select the initiator for the virtual disk from
the list of available initiators displayed for each cluster node, and then click
Next.
If you are configuring Multipath I/O (MPIO) over Fibre Channel (FC), you
must select at least two FC initiators for each cluster node. Note that the node
from which you run this wizard already has an initiator selected by default.
This is the initiator that was specified when you connected the LUNs to this
cluster node.

8

9

On the Service Group Summary panel, review the service group configuration
and change the resource names if desired and then click Next.
■

The Resources box lists the configured resources. Click on a resource to
view its attributes and their configured values.

■

The wizard assigns unique names to resources. Change names of the
resources, if desired.
To edit a resource name, select the resource name and either click it or
press the F2 key. Press the Enter key after editing each resource name.
To cancel editing a resource name, press the Esc key.

Click Yes on the message that informs you that the wizard will run commands
to create the service group.
Various messages indicate the status of these commands.

10 In the Completing the MSDTC Configuration Wizard panel, check Bring the
service group online check box if you wish to bring the configured service
group online on the local system. To bring the service group online later,
clear this check box.

11 Click Finish to exit the wizard.
This completes the MSDTC Server service group configuration. You can now
proceed to configure the MSDTC client manually.

Configuring an MSDTC service group for high availability
About configuring an MSDTC client

About configuring an MSDTC client
Configure the MSDTC client after configuring a service group for the MSDTC
Server. Set the MSDTC client to run on nodes where a SQL instance is configured
to run and the MSDTC server is not configured to run. In general, you must
configure the MSDTC client on all nodes except the nodes on which the MSDTC
Server is configured. You do not need to configure the MSDTC client on the nodes
that are part of the MSDTC Server service group.
The MSDTC client and the MSDTC Server must not run on the same cluster nodes.
Ensure the following before you configure the MSDTC client:
■

Verify that the MSDTC Server service group is online in the cluster.

■

Verify that the systems on which you plan to install the MSDTC client, have
a SQL instance configured on them.

Note: You have to configure the MSDTC client manually. You cannot use the
service group configuration wizard to configure the MSDTC client.

Configuring an MSDTC client
Complete the following steps to configure the MSDTC client.
To configure an MSDTC client

1

Ensure that the MSDTC Server service group is online in the cluster.

2

Launch the Windows Component Services Administrative tool.
Click Start > Programs > Administrative Tools > Component Services
or click Start > Run, type dcomcnfg and click OK.

3

In the console tree of the Component Services administrative tool, expand
Component Services > Computers, right-click My Computer and then click
Properties.

4

On the MSDTC tab perform the following steps:
■

Clear the Use local coordinator check box.

■

In the Remote Host field, type the virtual server name that you specified
while creating the MSDTC Server service group.
If you are unsure of the exact name, click Select to search from a list of
all computers on the network and select the virtual computer name from
the list.
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■

Click Apply and then click OK.

Verifying the installation
Verify your installation by switching online nodes or by shutting down the
computer that is currently online. Either process will test that the service group
can be smoothly transferred between nodes.
Shutting down a node creates an actual failure, stressing your system, but more
truly testing its high availability than by switching nodes. If you do shut down
the online computer in your cluster, remember to bring it back up after you have
confirmed that the service group successfully failed over to another node.
You must complete the procedure to verify the service group configuration.
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Configuring the standalone
SQL Server
This chapter includes the following topics:
■

Typical high availability configuration for a standalone SQL Server setup

■

Configuring a standalone SQL Server for high availablility

Typical high availability configuration for a standalone
SQL Server setup
This section describes the tasks needed to incorporate an existing standalone SQL
Server into a high available environment in order to ensure that the mission
critical SQL resource is always available.
It also describes the tasks necessary to create a virtual server in an active-passive
SQL configuration. The active node of the cluster hosts the virtual server. The
second node is a dedicated redundant server able to take over and host the virtual
server in the event of a failure on the active node.
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Figure 7-1

Active-Passive configuration

The virtual SQL Server is online on SYSTEM1, serving client requests. The shared
LUNs (virtual disks) provide storage for the SQL Server databases. SYSTEM2 waits
in a warm standby state as a backup node, prepared to begin handling client
requests if SYSTEM1 becomes unavailable. From the user’s perspective there will
be a small delay as the backup node comes online, but the interruption in effective
service is minimized.

Sample configuration
A sample setup is used through this guide to illustrate the installation and
configuration tasks.
During the configuration process you will create virtual IP addresses for the
following:
■

SQL virtual server
The IP address should be the same on all nodes.

■

Cluster IP address
The IP address is used by Veritas Cluster Manager (Web Console).

You should have these IP addresses available before you start deploying your
environment.
Table 7-1
Name

Objects used for clustering standalone server
Object

SYSTEM1 & SYSTEM2 server names; SYSTEM1 is the existing standalone SQL server
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Table 7-1

Objects used for clustering standalone server (continued)

Name

Object

INST1_SG

Microsoft SQL Server service group

SQL_CLUS1

virtual SQL server cluster

INST1_DG

Disk group for the volumes for the SQL instance

INST1_DATA_FILES

volume for Microsoft SQL Server system data files

INST1_DB1_VOL

volume for storing a Microsoft SQL Server user-defined database

INST1_DB1_LOG

volume for storing a Microsoft SQL Server user-defined database
log file

INST1_REGREP_VOL

volume that contains the list of registry keys that must be
replicated among cluster systems for the SQL server

INST1

SQL Instance Name

INST1-VS

name of the SQL Virtual Server

Configuring a standalone SQL Server for high
availablility
Perform the following tasks to configure the standalone SQL Server for high
availability, in an active-passive configuration with one to one failover capabilities:
Note: In addition to the tasks mentioned below, the procedures described in
Microsoft Knowledge Base Article - 224071: INF: Moving SQL Server databases
to a New Location with Detach/Attach are required.
Refer to: http://support.microsoft.com/default.aspx?scid=kb;en-us;224071.
Table 7-2 lists the tasks to configure the standalone SQL Server for high
availability.
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Table 7-2

Tasks to configure the standalone SQL Server for high availability

Task

Description

Prepare the standalone SQL Complete the following tasks before you begin the process
Server
of installing VCS and creating a clustered environment:
■

Back up the existing SQL data

■

From the SQL Server Service Manager, set the SQL Server
services to manual start.
While you set the SQL Server services to manual start,
you must select the standalone server that you plan to
incorporate, select the service from the Services list, and
then clear the Auto-start service when OS starts check
box.

Note: Repeat these steps for all other SQL Server services
that are running on the server.
Install and configure VCS on Install Veritas Cluster Server (VCS) on all the systems where
the standalone SQL server you want to configure the application. During installation,
the product installer installs the VCS agents required for
making the applications highly available.
Refer to the Veritas Cluster Server Installation and Upgrade
Guide for more information on installing VCS.
For details on configuring the VCS cluster, refer to,
See “Configuring the cluster using the Cluster Configuration
Wizard” on page 21.
Create volumes or LUNs
(virtual disks) necessary to
manage the SQL Server
storage.

See “Managing storage using NetApp filer ” on page 37.
See “Managing storage using Windows Logical Disk Manager
” on page 40.

Install and configure SQL
Perform the following tasks to install Microsoft SQL Server
Server on additional nodes, on additional nodes.
if required
■ Ensure that the shared volumes or LUNs are imported
on the node.
■ Ensure that the SQL Server configuration is identical on
all nodes in the cluster. To have identical configuration,
ensure that the instance name (if applicable), destination
folder for Program Files and Data Files and the
Authentication Mode are same on all the nodes.
■ Perform the SQL Server installation
See “About installing SQL Server 2005 on the second
node ” on page 52.
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Table 7-2

Tasks to configure the standalone SQL Server for high availability
(continued)

Task

Description

Move the existing SQL
Server data files and user
databases

After completing the SQL Server installation on the
additional nodes, move the existing standalone SQL Server
data files and user databases from the local drive to the
shared drives to ensure proper failover operations in the
cluster.

Configure the SQL Server
service group

See “About configuring the SQL service group ” on page 57.

Create and manage SQL
Server user-defined
database

See “Making SQL Server user-defined databases highly
available” on page 68.

Moving the existing SQL Server 2005 data files and user databases
After completing the SQL installation and configuration on the additional nodes,
move the existing standalone SQL Server data files and user databases from the
local drive to the shared drives to ensure proper failover operations in the cluster.
Complete the following tasks to move the databases:

1

From the SQL Server Service Manager, stop the SQL Server service.

2

Verify that you have backed up your existing data.

3

Import the volumes or LUNs to the node where the original files are located
on the local drives and mount the volumes (add drive letters).
See “Connecting virtual disks to the cluster node” on page 39.

4

Move the SQL Server data files and user databases to the shared volumes or
LUNs. Follow the procedures described in Microsoft Knowledge Base Article
- 224071: INF: Moving SQL Server databases to a New Location with
Detach/Attach.
Refer to: http://support.microsoft.com/default.aspx?scid=kb;en-us;224071.

5

Restart SQL Server.
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Configuring an active-active
cluster
This chapter includes the following topics:
■

About running SQL Server in an active-active clustered environment

■

Setting up the Active/Active cluster

About running SQL Server in an active-active
clustered environment
A SQL Server instance is a completely independent SQL Server installation, with
its own services, master database, storage, and memory resources. Each instance
is defined uniquely by a separate SQL Server virtual server and service group.
A SQL Server instance can fail over to any of the other nodes configured nodes
on its system list.
You can choose an active-active SQL Server configuration where several instances
are intended to run on a single node. However, remember that you must configure
failover nodes such that a single node can never host more than the number of
independent instances allowed by SQL Server.
The following figure illustrates a two node active-active configuration. The SQL
Server databases are configured on the shared storage on volumes or LUNs. Each
SQL Server virtual server is configured in a separate SQL Server service group.
Each service group can fail over to the other node in the cluster.
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Figure 8-1

Active-active configuration

For example, consider a two-node cluster hosting two SQL Server Virtual Servers,
BILLING_VS and PAYROLL_VS.
Table 8-1

Active-active configuration

SQL Virtual Server

Service Group

System List

BILLING_VS

BILLING_SG

SYSTEM1, SYSTEM2

PAYROLL_VS

PAYROLL_SG

SYSTEM2, SYSTEM1

Sample configuration
A sample setup is used to illustrate the installation and configuration tasks for
two instances of SQL server, Billing and Payroll. During normal operation, one
instance will be online on each of the two servers. If a failure occurs, the instance
on the failing node will be brought online on the other server, resulting in two
instances running on one server.
During the configuration process, create virtual IP addresses for the following:
■

Billing virtual server (virtual IP address is the same on all nodes)

■

Payroll virtual server (virtual IP address is the same on all node)

■

Cluster IP address

You should have these IP addresses available before you begin to deploy your
environment.
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The IP addresses are required only in case of IPv4. In an IPv6 network environment,
the configuration wizards automatically generate a unique and valid IPv6 address
based on the network prefix advertised by the routers.
Table 8-2 describes the objects created and used during the installation and
configuration.
Table 8-2

Active-active configuration objects

Name

Description

SYSTEM1 & SYSTEM2

server names

SQL_CLUS1

virtual SQL server cluster

BILLING_VS_SYS_FILES

volume for the SQL Server system data files for the
billing instance

PAYROLL_VS_SYS_FILES

BILLING_DATA
PAYROLL_DATA

BILLING_LOG
PAYROLL_LOG

BILLING_REGREP
PAYROLL_REGREP

volume for the SQL Server system data files for the
payroll instance
volume for a SQL Server user-defined database for
the billing instance
volume for a SQL Server user-defined database for
the payroll instance
volume for a SQL Server user-defined database log
file fort he billing instance
volume for a SQL Server user-defined database log
file for the payroll instance
volume for the list of registry keys replicated among
the nodes for the billing instance
volume for the list of registry keys replicated among
the nodes for the payroll instance

BILLING_INST
PAYROLL_INST

instance name for the billing instance

BILLING_VS
PAYROLL_VS

virtual SQL server name for the billing instance

BILLING_SG
PAYROLL_SG

SQL Server service group for the billing instance

instance name for the payroll instance

virtual SQL server name for the payroll instance

SQL Server service group for the payroll instance
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Setting up the Active/Active cluster
Perform the following tasks to configure an active-active SQL Server cluster:
Table 8-3 lists the tasks for setting up an active-active SQL Server cluster.
Table 8-3
Task

Description

Install VCS and configure Complete the VCS installation and the configure the cluster.
the cluster
See “About installing the VCS agents ” on page 21.
See “Configuring the cluster using the Cluster Configuration
Wizard” on page 21.
Configure volumes or
virtual disks for SQL
Server

For each instance of SQL Server (SQL Server system data files
and the registry keys replicated among cluster nodes), create
volumes or LUNs (virtual disks) on the shared storage.
See “Managing storage using NetApp filer ” on page 37.
See “Managing storage using Windows Logical Disk Manager
” on page 40.

Install the first instance
of SQL Server

Consider the following points while you install the first instance
of SQL Server:
Do not accept the default instance name. Specify an instance
name for each SQL Server installation.
■ Each SQL Server instance must be assigned a different port.
The default port is 1433; ports for subsequent instances are
generally assigned in descending order (1432, 1431, 1430,
etc.).
■ Set a unique internal name for each instance.
■

See “Installing SQL Server 2005 on the first node ” on page 47.
Configure the service
group for the first SQL
Server instance

Consider the following points as you configure the SQL Server
service group for the first instance:
■

Assign a unique name to the SQL Server service group.

■

Pay close attention to the priority order of the systems. For
example, if the system priority for the first instance is
SYSTEM1 then SYSTEM2; reverse the priority order for the
second instance, so that SYSTEM2 has a higher priority.

See “About configuring the SQL service group ” on page 57.
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Table 8-3

(continued)

Task

Description

Configure the service
group for user-defined
databases, if any

You can use VCS to manage user-defined SQL Server databases.
Create the required SQL databases using the SQL Server
Management Studio and then make them highly available with
VCS.
See “Making SQL Server user-defined databases highly
available” on page 68.

Repeat the SQL Server
installation and service
group configuration for
additional instances

To install and configure one or more additional SQL Server
instances, follow the same procedures as when installing the
first instance.
Make the same changes to the process, as follows:
Do not accept the default instance name. Specify a unique
instance name for each SQL Server installation.
■ Each SQL Server instance must be assigned a different port.
The default port is 1433; ports for subsequent instances are
generally assigned in descending order (1432, 1431, 1430,
etc.).
■ Set a unique internal name for each instance.
■

See “Installing SQL Server 2005 on the first node ” on page 47.
Consider the following points as you configure the SQL Server
service groups for the additional instances:
■

Assign a unique name to the SQL Server service group

■

Pay close attention to the priority order of the systems. For
example, if the system priority for the first instance is
SYSTEM1 then SYSTEM2; reverse the priority order for the
second instance, so that SYSTEM2 has a higher priority.

See “About configuring the SQL service group ” on page 57.
Configure the service group for user-defined databases, if any.
See “Making SQL Server user-defined databases highly
available” on page 68.
Verify the configuration

See “Verifying the service group configuration ” on page 71.
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Chapter

9

Configuring a disaster
recovery setup
This chapter includes the following topics:
■

Setting up the disaster recovery cluster

■

What needs to be protected in a SQL Server environment

■

Typical SQL Server disaster recovery cluster configuration

■

Configuring a disaster recovery set up for SQL Server

Setting up the disaster recovery cluster
A disaster recovery (DR) solution is a series of procedures you can use to safely
and efficiently restore application data and services in the event of a catastrophic
failure. A typical DR solution requires clusters on primary and secondary sites
with replication between those sites. The cluster on the primary site provides data
and services during normal operation; the cluster on the secondary site provides
data and services if the cluster on the primary site fails.
Symantec recommends that you configure the secondary site only after you have
established a local cluster with the GCO Option at the primary site.

Why implement a disaster recovery solution
A DR solution is vital for businesses that rely on the availability of data.
A well-designed DR solution prepares a business for unexpected disasters and
provides the following benefits in a DR situation:
■

Minimizes economic loss due to the unavailability or loss of data.
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■

Provides a plan for the safe and orderly recovery of data in the event of a
disaster.

■

Ensures safe and efficient recovery of data and services.

■

Minimizes any decision making during DR.

■

Reduces the reliance on key individuals.

Strategically planning a DR solution provides businesses with affordable ways to
meet their service level agreements, comply with government regulations, and
minimize their business risks.
Note: A DR solution requires a well-defined backup strategy. Refer to your backup
product documentation for information on configuring backup.

Understanding replication
The term replication refers to the use of a tool or service to automate the process
of maintaining a consistent copy of data from a designated source (primary site)
on one or more remote locations (secondary sites).
In the event that the primary site data center is destroyed, the application data
is readily available at the remote site, and the application can be restarted at the
remote site. Refer to the NetApp documentation for more information on
replication in a NetApp storage environment.

What needs to be protected in a SQL Server
environment
The following components of a SQL server environment must be protected in the
event of a disaster:
■

User Databases
The most critical component in any SQL Server implementation is the user
data that is stored in user-defined databases.

■

Logins
Logins allow clients to connect to SQL Server and execute queries on user data.
Logins are stored in the master database and each of the user-defined databases.

■

Jobs
Jobs are a set of scheduled tasks that maintain SQL Server databases. The job
configuration is stored in the msdb system database.

■

Alerts
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Alerts are actions that are taken when a specific event occurs. They are used
to respond to and correct errors that occur in SQL Server. The alert
configuration is stored in the msdb system database.
■

Operators
Operators are contacts that address problems occurring in SQL Server. They
are notified in the event of errors. The operator configuration is stored in the
msdb system database.

■

Extended Stored Procedures
Extended stored procedures are external routines that are called from within
SQL Server. They are typically stored in DLL files on the file system.

■

Other Server Extensions
SQL Server is a very flexible database engine and it is possible to extend its
functionality in several ways. These extensions are also important to the
operation of the SQL Server.

Typical SQL Server disaster recovery cluster
configuration
A Disaster Recovery (DR) configuration enables you to restore application data
and services in the event of a catastrophic failure. A typical DR solution requires
primary and secondary sites, and clusters within those sites. The clusters at the
primary and secondary sites are a part of the global cluster. The cluster at the
primary site provides data and services during normal operation, and the cluster
at the secondary site provides data and services if the primary site fails. VCS
continuously monitors and communicates events between clusters. Inter-cluster
communication ensures that the global cluster is aware of the state of the global
service group at all times.
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Figure 9-1

Typical disaster recovery configuration

The illustration displays an environment with a DR solution that is prepared for
a disaster. The primary site consists of two nodes, System1 and System2. The
secondary site consists of two nodes, System3 and System4. Each site has a
clustered setup with the nodes set up appropriately for failover within the site.
Note: The figure depicts a typical configuration. The number of systems at the
primary and secondary site clusters need not be the same.
Data is replicated from the primary site to the secondary site. Replication between
the storage is set up using a replication software. In case of a NetApp environment,
replication between the filers at the primary and secondary sites is set up using
NetApp SnapMirror for SQL. If the Microsoft SQL Server server on System1 fails,
SQL Server comes online on node System2 and begins servicing requests. From
the user’s perspective there might be a small delay as the backup node comes
online, but the interruption in effective service is minimal.
When a failure occurs, such as an earthquake that destroys the data center in
which the primary site resides, the DR solution is activated. VCS fails over the
entire service group to the cluster at the secondary site. System3 at the secondary
site takes over, and the data that was replicated to the secondary site is used to
restore the application services to clients.

Configuring a disaster recovery set up for SQL Server
This section provides information on how to install and configure the high
availability and SQL Server components on the primary and secondary sites, with
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the intent of creating a parallel setup for the SQL service group on both sites. The
configuration process is the same for both sites.
Note: You must perform the tasks at the primary site first. After the configuration
is complete at the primary site, proceed to perform the tasks at the secondary
site.
Also, before you begin to configure the secondary site, offline the SQL Server
resource, the SQL virtual server name resource, the MSSearch resource (if present),
and the SQL virtual IP resource on the primary site.
Before you begin to create the SQL Server service group for the cluster at the
secondary site, make sure that the SQL Server service group at the primary site
is offline.
Table 9-1 lists the tasks to set up a disaster recovery environment for SQL Server.
Table 9-1

Tasks for SQL Server disaster recovery set up

Task

Description

Review the
configuration

Review the system configuration before you start deploying VCS
and SQL Server in your environment.
See “About installing the VCS agents ” on page 21.
See “Before configuring the SQL service group ” on page 58.

Install VCS and
configure the cluster

Ensure that you perform the following tasks while you install
VCS and configure the cluster:
Select the Global Cluster Option for VCS to enable wide-area
failover.
■ Configure cluster components including the Wide-Area
Connector (WAC) resource for global clusters, using the VCS
Cluster Configuration Wizard (VCW).
■

See “About installing the VCS agents ” on page 21.
See “Configuring the cluster using the Cluster Configuration
Wizard” on page 21.
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Table 9-1

Tasks for SQL Server disaster recovery set up (continued)

Task

Description

Configure volumes or
LUNs on the shared
storage

Create volumes or LUNs required for SQL Server and ensure that
the volumes or LUNs (virtual disks) are connected to the first
cluster node.
During the creation of virtual disks and volumes for the
secondary site, make sure the following is exactly the same as
the cluster on the primary site:
■

Volume sizes

■

Volume names

■

Drive letters

See “Managing storage using NetApp filer ” on page 37.
See “Managing storage using Windows Logical Disk Manager ”
on page 40.
Install and configure
See “Installing SQL Server 2005 on the first node ” on page 47.
SQL Server on the first
node
Install and configure
SQL Server on the
additional nodes

See “About installing SQL Server 2005 on the second node ”
on page 52.

Note: The instance name must be the same on the primary site
and secondary site.

Configure the SQL
Server service group

See “About configuring the SQL service group ” on page 57.

Note: The service group name and virtual computer name must
be same on both, the primary site and secondary site.

Configure DR
components

After configuring the high availability and SQL Server
components on the primary and secondary sites, complete the
disaster recovery solution by configuring the disaster recovery
components for both sites.
See “Prerequisites ” on page 106.
See “Linking clusters: Adding a remote cluster to a local cluster
” on page 106.
See “Converting a local service group to a global service group ”
on page 108.
See “Bringing a global service group online ” on page 110.
See “Administering global service groups ” on page 110.
See “Deleting a remote cluster ” on page 111.
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Configuring replication using NetApp SnapMirror
You can replicate SQL Server data by establishing a SnapMirror relationship
between the filers at the primary and secondary sites. Before configuring
replication, make sure the service group is offline at the secondary site.
SnapMirror replicates snapshots taken on a filer and applies them to a remote
filer over a wide area network; these snapshots can be used by the target host to
provide rapid failover in case of a disaster.
If required, you can transfer the initial base snapshot image from the primary to
secondary via tape, and then set up incremental SnapMirror updates to the
destination filer. After you set up a SnapMirror relationship, ensure that the state
of the volumes (that are to be replicated) at the primary site shows as
SnapMirrored.
Refer to NetApp documentation for more information.

Configuring SnapMirror resources at the primary site
Configure NetAppSnapMirror resources at the primary site to monitor data
replication from the primary to the secondary site. Creating a resource at the
primary site will enable the filer to replicate from the primary to the secondary
site.
You may want to repeat this procedure and create a NetAppSnapMirror resource
at the secondary site.
This is required in cases such as the following:
■

the service group is online at the secondary site (either it is failed over or
switched to the secondary site) and the filer should replicate from secondary
to primary site

■

if you want to fail over or switch the service group from the secondary to the
primary site

Use the SQL Server Configuration Wizard to add the SnapMirror resource. Verify
that the volumes or LUNs created to store the registry replication information
and the SQL Server database are connected to the node on which you run the
wizard, and disconnected from other nodes in the cluster.

Configuring the Global Cluster Option for wide-area failover
The Global Cluster option is required to manage global clustering for wide-area
disaster recovery.
Creating a global cluster environment involves the following:
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■

Connecting standalone clusters by adding a remote cluster to a local cluster.

■

Converting the local service group that is common to all the clusters to a global
service group.

You need to create a wide-area connector resource for global clusters.
You can use the VCS Java Console to perform global cluster operations; this guide
only provides procedures for the Java Console. Refer to the Veritas Cluster Server
Administrator’s Guide for more information on GCO operations available from
the Java Console and the command line.

Prerequisites
Creating a global cluster environment requires the following:
■

Wide-area Connector process is configured and the ClusterService group is
online at both sites.
See “Configuring Wide-Area Connector process for global clusters” on page 33.

■

All service groups properly configured and able to come online.

■

The service group serving as the global group has the same unique name across
all applicable clusters.

■

The clusters use the same version of VCS.

■

The clusters use the same operating system.

■

The clusters are standalone and do not already belong to a global cluster
environment.

■

The names of the clusters at the primary and secondary sites and the virtual
IP addresses associated with them are registered in the DNS with reverse
lookup.

Linking clusters: Adding a remote cluster to a local cluster
The VCS Java Console provides a wizard to create global clusters by linking
standalone clusters or bringing a standalone cluster into an existing global
environment.
You can run the wizard from the following locations:
■

If you are creating a global cluster environment for the first time with two
standalone clusters, run the wizard from either the cluster on the primary site
or the cluster on the secondary site.

■

If you are adding a standalone cluster to an existing global cluster environment,
run the wizard from a cluster already in the global cluster environment.
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The following information is required for the Remote Cluster Configuration Wizard
in Cluster Explorer:
■

The active host name or IP address of each cluster in the global configuration
and of the cluster being added to the configuration.

■

The user name and password of the administrator for each cluster in the
configuration.

■

The user name and password of the administrator for the cluster being added
to the configuration.
Symantec does not support adding a cluster that is already part of a global
cluster environment. To merge the clusters of one global cluster environment
(for example, cluster A and cluster B) with the clusters of another global
environment (for example, cluster C and cluster D), separate cluster C and
cluster D into standalone clusters and add them one by one to the environment
containing cluster A and cluster B.

To add a remote cluster in Cluster Explorer

1

From Cluster Explorer, click Add/Delete Remote Cluster on the Edit menu.
or
From the Cluster Explorer configuration tree, right-click the cluster name,
and click Add/Delete Remote Cluster.

2

Review the required information for the Remote Cluster Configuration Wizard
and click Next.

3

In the Wizard Options panel, click Add Cluster, then click Next.

4

In the New Cluster Details panel, enter the details of the new cluster.
If the cluster is not running in secure mode, do the following:
■

Enter the host name of a cluster system, an IP address of a cluster system,
or the IP address of the cluster that will join the global environment.

■

If necessary, change the default port number.

■

Enter the user name.

■

Enter the password.

■

Click Next.

If the cluster is running in secure mode, do the following:
■

Enter the host name of a cluster system, an IP address of a cluster system,
or the IP address of the cluster that will join the global environment.

■

Verify the port number.
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■

Choose to connect to the remote cluster with the credentials used for the
current cluster connection, or enter new credentials, including the user
name, password, and the domain.

■

If you connected to the remote cluster earlier through the wizard, you can
use the credentials from the previous connection.

■

Click Next.

5

Click Finish. After running the wizard, the configurations on all the relevant
clusters are in read-write mode; the wizard does not close the configurations.

6

Verify that the heartbeat connection between clusters is alive. From the
command window enter hahb -display. The state attribute in the output
should show alive.
If the state is unknown, then offline and online the ClusterService group.

Converting a local service group to a global service group
After linking the clusters, use the Global Group Configuration wizard to convert
a local service group that is common to the global clusters to a global group. This
wizard also enables you to convert global groups into local groups.
To convert a local service group to a global group

1

From Cluster Explorer, click Configure Global Groups on the Edit menu.
or
From the Cluster Explorer configuration tree, right-click the cluster, and click
Configure Global Groups.
or
From the Cluster Explorer configuration tree, right-click the service group,
click Configure As Global, and proceed to step 3b.

2

Review the information required for the Global Group Configuration wizard
and click Next.

3

Enter the details of the service group to modify as follows:
■

Click the name of the service group that will be converted from a local
group to a global group, or vice versa.

■

From the Available Clusters box, click the clusters on which the group can
come online. Click the right arrow to move the cluster name to the Clusters
for Service Group box; for global to local cluster conversion, click the left
arrow to move the cluster name back to the Available Clusters box. A
priority number (starting with 0) indicates the cluster on which the group
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will attempt to come online. If necessary, double-click the entry in the
Priority column and enter the new value.
■

■

4

Select the policy for cluster failover as follows:
Manual

Prevents a group from automatically failing over to another
cluster.

Auto

Enables a group to automatically fail over to another cluster
if it is unable to fail over within the cluster, or if the entire
cluster fails.

Connected

Enables a group to automatically fail over to another cluster
if it is unable to fail over within the cluster.

Click Next.

Enter or review the connection details for each cluster. Click the Configure
icon to review the remote cluster information for each cluster:
Cluster not in
secure mode

Cluster in secure
mode

Enter the IP address of the remote cluster, the IP address of
a cluster system, or the host name of a cluster system.
■ Verify the port number.
■

■

Enter the user name.

■

Enter the password.

■

Click OK.

■

Repeat these steps for each cluster in the global environment.

Enter the IP address of the remote cluster, the IP address of
a cluster system, or the host name of a cluster system.
■ Verify the port number.
■

Choose to connect to the remote cluster with the credentials
used for the current cluster connection, or enter new
credentials, including the user name, password, and domain.
■ If you connected to the remote cluster earlier through the
wizard, you can use the credentials from the previous
connection.
■ Click OK.
■

■

5

Repeat these steps for each cluster in the global environment.

Click Next, then click Finish.
At this point, you must bring the global service group online from Cluster
Explorer.
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Bringing a global service group online
After converting the local service group that is common to the global clusters to
a global group, use the Cluster Explorer to bring the global service group online.
To bring a remote global service group online from Cluster Explorer

1

In the Service Groups tab of the configuration tree, right-click the service
group.
or
Click a cluster in the configuration tree, click the Service Groups tab, and
right-click the service group icon in the view panel.

2

Click Online, and click Remote online.

3

In the Online global group dialog box, do the following:
■

Click the remote cluster to bring the group online.

■

Click the specific system, or click Any System, to bring the group online.

■

Click OK.

Administering global service groups
Administering global groups requires the following conditions:
■

A group that will serve as the global group must have the same name across
all applicable clusters.

■

You must know the user name and password for the administrator to each
cluster in the configuration.

Use the VCS Java Console or Web Console to bring a global group online, take a
global group offline, or switch a global group on a remote cluster. The section
below provides additional procedures for administering global groups from the
Java Console. Refer to the Veritas Cluster Server Administrator’s Guide for more
information on global cluster operations from the Java Console and Web Console.
Note: For remote cluster operations, the user must have the same name and
privilege as the user logged on to the local cluster.

Taking a remote global service group offline
Use Cluster Explorer to take a remote global service group offline.
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To take a remote global service group offline from Cluster Explorer

1

In the Service Groups tab of the configuration tree, right-click the service
group.
or
Click a cluster in the configuration tree, click the Service Groups tab, and
right-click the service group icon in the view panel.

2

Click Offline, and click Remote offline.

3

In the Offline global group dialog box do the following:
■

Click the remote cluster to take the group offline.

■

Click the specific system, or click All Systems, to take the group offline.

■

Click OK.

Switching a remote service group
Use Cluster Explorer to switch a remote service group.
To switch a remote service group from Cluster Explorer

1

In the Service Groups tab of the configuration tree, right-click the service
group.
or
Click a cluster in the configuration tree, click the Service Groups tab, and
right-click the service group icon in the view panel.

2

Click Switch To, and click Remote switch.

3

In the Switch global group dialog box do the following:
■

Click the cluster to switch the group.

■

Click the specific system, or click Any System, to take the group offline.

■

Click OK.

Deleting a remote cluster
If necessary, use the Remote Cluster Configuration wizard to delete a remote
cluster.
Note: You cannot delete a remote cluster if the cluster is part of a cluster list for
global service groups or global heartbeats, or if the cluster is in the RUNNING,
BUILD, INQUIRY, EXITING, or TRANSITIONING states.
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Deleting a remote cluster involves the following tasks:
■

Taking the wide area cluster (wac) resource in the ClusterService group offline
on the cluster that will be removed from the global environment. For example,
to delete cluster C2 from a global environment containing C1 and C2, log on
to C2 and take the wac resource offline.

■

Removing the name of the specified cluster (C2) from the cluster lists of the
other global groups using the Global Group Configuration wizard. Note that
the Remote Cluster Configuration wizard in Cluster Explorer automatically
updates the cluster lists for heartbeats. Log on to the local cluster (C1) to
complete this task before using the Global Group Configuration wizard.

■

Deleting the cluster (C2) from the local cluster (C1) through the Remote Cluster
Configuration wizard.

Use Cluster Explorer to take the wide area cluster resource offline, remove a
cluster from the cluster list for a global group, and delete a remote cluster from
the local cluster.
To take the wide area cluster (wac) resource offline

1

From Cluster Monitor, log on to the cluster that will be deleted from the global
cluster environment.

2

In the Service Groups tab of the Cluster Explorer configuration tree, right-click
the wac resource under the Application type in the ClusterService group.
or
Click a service group in the configuration tree, click the Resources tab, and
right-click the wac resource in the view panel.

3

Click Offline, and click the appropriate system from the menu.

To remove a cluster from a cluster list for a global group

1

From Cluster Explorer, click Configure Global Groups on the Edit menu.

2

Click Next.

3

Enter the details of the service group to modify, as follows:

4

■

Click the name of the service group.

■

For global to local cluster conversion, click the left arrow to move the
cluster name from the cluster list back to the Available Clusters box.

■

Click Next.

Enter or review the connection details for each cluster. Click the Configure
icon to review the remote cluster information for each cluster:
If the cluster is not running in secure mode, do the following:
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■

Enter the IP address of the remote cluster, the IP address of a cluster
system, or the host name of a cluster system.

■

Verify the port number.

■

Enter the user name.

■

Enter the password.

■

Click OK.

If the cluster is running in secure mode, do the following:
■

Enter the IP address of the remote cluster, the IP address of a cluster
system, or the host name of a cluster system.

■

Verify the port number.

■

Choose to connect to the remote cluster using the connected cluster’s
credentials, or enter new credentials, including the user name, password,
and domain.

■

Click OK.

5

Click Next.

6

Click Finish.

To delete a remote cluster from the local cluster

1

From Cluster Explorer, click Add/Delete Remote Cluster on the Edit menu.
or
From the Cluster Explorer configuration tree, right-click the cluster name,
and click Add/Delete Remote Clusters.

2

Review the required information for the Remote Cluster Configuration wizard
and click Next.

3

On the Wizard Options panel, click Delete Cluster, then click Next.

4

In the Delete Cluster panel, click the name of the remote cluster to delete,
then click Next.

5

Review the connection details for each cluster. Click the Configure icon to
review the remote cluster information for each cluster:
If the cluster is not running in secure mode do the following:
■

Enter the IP address of the remote cluster, the IP address of a cluster
system, or the host name of a cluster system.

■

Verify the port number.

■

Enter the user name.
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■

Enter the password.

■

Click OK.

If the cluster is running in secure mode do the following:

6

■

Enter the IP address of the remote cluster, the IP address of a cluster
system, or the host name of a cluster system.

■

Verify the port number.

■

Choose to connect to the remote cluster with the credentials used for the
current cluster connection, or enter new credentials, including the user
name, password, and the domain.
If you connected to the remote cluster earlier through the wizard, you can
use the credentials from the previous connection.

■

Click OK.

Click Finish.
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Troubleshooting VCS
agents for NetApp and
Microsoft SQL Server
This chapter includes the following topics:
■

About troubleshooting VCS agents for NetApp and Microsoft SQL Server

■

VCS logging

■

VCS Cluster Configuration Wizard (VCW) logs

■

VCWsilent logs

■

NetApp agents error messages

■

SQL Server agent error messages and descriptions

About troubleshooting VCS agents for NetApp and
Microsoft SQL Server
This chapter describes how to troubleshoot common problems in the VCS agents
for NetApp and Microsoft SQL Server. The chapter lists the error messages, and
describes the problem associated with the agent. Recommended solution is
included, where applicable.
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VCS logging
VCS generates two error message logs: the engine logs and the agent logs. Log file
names are appended by letters. Letter A indicates the first log file, B the second,
C the third, and so on.
The agent log is located at %VCS_HOME%\log\agent_A.txt. The format of agent
log messages is:
Timestamp (Year/MM/DD) | Mnemonic | Severity | UMI | Agent Type | Resource
Name | Entry Point | Message Text
Table 10-1 describes the agent log message components and their descriptions.
Table 10-1

Log message components and their description

Log message component

Description

Timestamp

Denotes the date and time when the message was logged.

Mnemonic

Denotes which Symantec product logs the message. For
Veritas Cluster Server, the mnemonic is ‘VCS’.

Severity

Denotes the severity of the message. Severity is classified
into the following types:
CRITICAL indicates a critical error within a VCS process.
Contact Technical Support immediately.
■ ERROR indicates failure of a cluster component,
unanticipated state change, or termination or
unsuccessful completion of a VCS action.
■ WARNING indicates a warning or error, but not an actual
fault.
■ NOTE informs the user that VCS has initiated an action.
■

■

INFO informs the user of various state messages or
comments.
Among these, CRITICAL, ERROR, and WARNING indicate
actual errors. NOTE and INFO provide additional
information.
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Table 10-1

Log message components and their description (continued)

Log message component

Description

UMI or Unique Message ID

UMI is a combination of Originator ID, Category ID, and
Message ID. For example, the UMI for a message generated
by the SQLServer agent would resemble: V-16-xxxxx-yy.
Originator ID for all VCS products is ‘V-16.’ Category ID for
the agents is as follows:
■

SQL Server 2000: 20020

■

SQL Server 2005: 20050

■

SQL Server 2005 Agent Service: 20051

■

SQL Server 2005 OLAP: 20052

■

SQL Server 2008: 20069

■

SQL Server 2012: 20093

■

SQL Server Filestream: 20070

■

MSTDC: 20021

Message ID is a unique number assigned to the message
text.
Message Text

Denotes the actual message string.

You can view these message logs using Notepad or any text editor. All messages
are logged to the engine and the agent logs. Messages of type CRITICAL and ERROR
are written to the Windows event log.
A typical agent log resembles:
2010/01/12 11:22:47 VCS NOTICE V-16-20020-10
SQLServer2005:SQL-Group-SQLServer2005:monitor:SQL Server
Instance name is not specified. Agent will operate on default
instance.

VCS Cluster Configuration Wizard (VCW) logs
The VCS Cluster Configuration Wizard (VCW) log is located at
%allusersprofile%\Veritas\Cluster Server\vcw.log.
Here, %allusersprofile% is the file system directory containing application data
for all users. A typical path is C:\ProgramData\.
The format of the wizard log is of the format ThreadID | Message Text.
ThreadID is the ID of the thread initiated by the wizard and Message Text is the
actual message generated by the wizard.
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A typical wizard log resembles the following:
00000576-00000264: ExecMethod return 00000000.
00000576-00000110: CRegistry::Query for VCS License failed.
Error=0x00000000
00000576-00000264: ExecMethod return 00000000.
00000576-00000264: ExecMethod return 00000001.
00000576-00000127: QueryDWORDValue returned 0x00000001
00000576-00000132: CRegistry::Query for VxSS Root information
failed. Error=0x00000001

VCWsilent logs
The VCWsilent log is located at <currentdirectory>\vcwsilent.log.
Here, <currentdirectory> is the directory from where the VCWsilent.exe is run.
A typical VCWsilent log resembles the following:
00005540-00000064: 5540: STARTING - Discovering NICs on the
selected machines...
00009956-00000064: 9956: STARTING - Generating private network
related files...
00009956-00000048: 9956: COMPLETED - Gererating LLT host
files...
00009956-00000048: 9956: COMPLETED - Generating GAB tab files...
00009956-00000048: 9956: COMPLETED - Generating main.cf file...
00009956-00000064: 9956: STARTING - Configuring LLT on all the
nodes.
00009956-00000048: 9956: COMPLETED - Configuring LLT on all the
nodes.

NetApp agents error messages
Table 10-2 contains a list of error messages for the VCS agents for NetApp.
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Table 10-2

NetApp agents error messages

Message

Description

Failed to open connection to Make sure that the VCS Helper Service account has is a
filer %s.
domain user and is part of the administrator's group on the
local host and the filer.
Make sure the private network is functioning properly.
Verify you can ping the IP used for the private storage
network. This is the IP defined the StorageIP attribute of
the NetAppFiler resource.
Failed to initialize ONTAPI
on system

The agent could not find the file NTAPADMIN.DLL on the
system. Verify the file exists in the %VCS_HOME%\bin
directory

Invalid attributes exist in the Some agent attributes have not been defined or have been
configuration
defined incorrectly. Verify the configuration definition for
the agent.
ONTAP API called failed for The specified API failed on the specified object. See the
object_name on filer_name. NetApp ONTAP API documentation for information about
the associated error message
Volume %s on filer %s is not Verify replication is set up on the specified volume.
a SnapMirror replicated
volume
Multiple snapmirror
There should be only one destination per source volume.
destinations for a volume is
not supported by this agent.
'snapmirror status' for
volume %s on filer %s
returned multiple status
entries. Administrative
intervention required
Initialize
The agent could not detect the iSCSI or the FC Initiator on
VLibNetAppHost::Initialize() the host.
failed. (error_type: %s,
Make sure that you have installed and configured Microsoft
error_code: 0x%s)
iSCSI Initiator or an FC Initiator on each node.
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Table 10-2

NetApp agents error messages (continued)

Message

Description

Failed to connect/disconnect This could occur because one or more of the following
virtual disk. (error_type: %s, parameters are defined incorrectly in the VCS configuration:
error_code: 0x%s.
■ Filer name
error_message: %s)
■ Volume name/LUN name
■

Share name

■

Storage IP

Verify the configuration definition of the resource. Make
sure each attribute is defined correctly.
Unable to create/delete
online lock file %s. Error
code %s,

Make sure you have write permissions on the specified
directory.

SQL Server agent error messages and descriptions
This section lists the messages of type ERROR and WARNING. Each message
includes a description and a recommended solution, if applicable.

Agent for MSDTC error messages
Table 10-3 describes the error messages for the MSDTC agent.
Table 10-3

MSDTC agent error messages

Message

Description

Lanman attribute has not been configured. No value specified for the LanmanResName
attribute.
Solution: Specify a valid value for the
LanmanResName attribute.
MountResName attribute has not been
configured.

No value specified for MountResName
attribute.
Solution: Specify a valid value for the
MountResName attribute.

LogPath attribute has not been configured. No value specified for LogPath attribute.
Solution: Specify a valid value for the
MountResName attribute.
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Table 10-3

MSDTC agent error messages (continued)

Message

Description

Failed to open the SCM handle. Error =
Error code.

The agent fails to get a handle to the Service
Control Manager (SCM). This could occur if
the specified SCM database does not exist or
the requested access is denied.
Solution: Verify that SCM can be run on the
host. See the associated Windows error code
for more information.

Failed to open the MSDTC service. Error = The agent failed to open the MSDTC service
Error code.
from the Service Control Manager (SCM).
Solution: Check whether the service is present
in the Service Control Manager.
Failed to start the MSDTC service. Error = The agent failed to start the MSDTC service.
Error code.
See the associated Windows error code for
more information.
The MSDTC log path is 'path name'.
Configured one is 'path name'.

The specified path for the MSDTC logs is
different from the actual path.
Solution: Specify the correct MSDTC log path.

The MSDTC service is not in running state. The MSDTC service could be in PAUSE, PAUSE
Offline might be unsuccessful.
PENDING, or START PENDING state.
Solution: Resume the service and then attempt
to stop it.
Failed to stop the MSDTC service. Error = The MSDTC service could not be stopped. See
Error code.
the associated Windows error code for more
information.
Failed to wait for the MSDTC service to
stop. Error = Error code.

The agent could not stop the service within
the specified time limit of 20 seconds. See the
associated Windows error code for more
information.

Agent for SQL Server 2005 error messages
Table 10-4 describes the error messages for the SQL Server 2005 agent.
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Table 10-4

SQL Server 2005 agents error messages

Message

Description

Failed to convert the argument list. Error =
Error code.

This is a VCS internal error.
Solution: Contact Symantec Technical
Support.

Invalid value specified for attribute attribute No value provided for the specified
name.
attribute.
Solution: Provide a value for the attribute.
Failed to initialize the SQLServer2005 agent. The agent failed to initialize the
SQLServer2005 agent for SQL Server 2005.
Failed to open the SCM handle. Error = Error The agent fails to get a handle to the
code.
Service Control Manager (SCM). This could
occur if the specified SCM database does
not exist or the requested access is denied.
Solution: Verify that SCM can be run on
the host. See the associated Windows error
code for more information.
The service service name is not in stopped
state.

The service is in an invalid state.
Solution: Check the state of the service.

Failed to start the service service name. Error The agent failed to start the service.
= Error code.
Solution: See the associated Windows error
code for more information.
SQL Server Instance name is not specified.
Agent will operate on the default instance.

No value spaced-out for SQL Server
instance name. Agent would operate on the
default SQL Server instance.

Failed to set the virtual computer name in the This is a VCS internal error.
environment of the service service name. Error
Solution: Contact Symantec Technical
= Error code.
Support.
The service service name did not start within The agent failed to start the service within
the specified time limit.
the time limit as specified in the
SQLOnlineTimeout attribute.
Failed to wait for the service service name to
start. Error = Error code.

This is a VCS internal error.
Solution: Contact Symantec Technical
Support.
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Table 10-4

SQL Server 2005 agents error messages (continued)

Message

Description

The service name service is not in stopped or The service is in an invalid state.
running state. State=state name.
Failed to get the password attribute. Error =
Error code.

Incorrect encrypted password specified for
detail monitoring.
Solution: Provide a password that is
encrypted using the ‘VCSencrypt’ utility.

Failed to convert the password attribute. Error This is a VCS internal error.
= Error code.
Solution: Contact Symantec Technical
Support.
Failed to open the service service name. Error The agent failed to open the service from
= Error code.
the Service Control Manager.
Solution: Check whether the service is
present in the Service Control Manager.
Failed to query the status of the service service The agent failed to query the state of the
name. Error = Error code.
service.
Solution: Check whether the service is
present in the Service Control Manager.
The service service name is not in running
state. Attempt to stop it might be
unsuccessful.

The SQL Server service could be in PAUSE,
PAUSE PENDING, or START PENDING
state.
Solution: Resume the service and then
attempt to stop it.

The service service name did not stop. Error
= Error code.

The agent failed to stop the service. See the
associated Windows error code for more
information.

The service service name did not stop within
the specified timeout. Error = Error code.

The agent failed to stop the service within
the time limit as specified in the
SQLOfflineTimeout attribute.

Sql script has failed with error error code.

The SQL script for detail monitoring failed.
See the associated Windows error code for
more information.

Error occurred while getting the process exit This is a VCS internal error.
code. Error = Error code.
Solution: Contact Symantec Technical
Support.
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Table 10-4

SQL Server 2005 agents error messages (continued)

Message

Description

WaitForSingleObject failed with error
error code.

This is a VCS internal error.

The password attribute has not been
configured.

The password attribute used for detail
monitoring is not configured.

Solution: Contact Symantec Technical
Support.

Failed to start the Sql script. (User = user
The agent failed to execute the script for
name, Domain = domain name) Error = Error detail monitoring. See the associated
code.
Windows error code for more information.
Unable to convert the buffer to UNICODE.
Error = Error code

This is a VCS internal error.

Sql script failed. Script output : output

The SQL script failed to monitor the SQL
Server instance. See the script output for
more information.

Failed to get the temporary file path. Error :
Error code

This is a VCS internal error.

Failed to create the temporary file. Error =
Error code.

This is a VCS internal error.

Failed read the temporary file. Error = Error
code.

This is a VCS internal error.

Failed to remove the virtual name
environment for the service service name.

This is a VCS internal error.

Solution: Contact Symantec Technical
Support.

Solution: Contact Symantec Technical
Support.

Solution: Contact Symantec Technical
Support.

Solution: Contact Symantec Technical
Support.

Solution: Contact Symantec Technical
Support.

Agent for SQL Server 2005 Agent service error messages
Table 10-5 describes the error messages for the SQL Server 2005 Agent service
agent.
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Table 10-5

SQL Server 2005 Agent service agent error messages

Message

Description

Failed to convert the argument list. Error =
Error code.

This is a VCS internal error.
Solution: Contact Symantec Technical
Support.

Invalid value specified for attribute attribute No value provided for the specified
name.
attribute.
Solution: Provide a value for the attribute.
Failed to initialize the SQLAgService2005
agent.

The agent failed to initialize the
SQLAgService2005 agent for the SQL
Server 2005 Agent Service.
Solution: Verify whether the
SQLAgService2005 agent exists.

Failed to open the SCM handle. Error = Error The agent fails to get a handle to the
code.
Service Control Manager (SCM). This could
occur if the specified SCM database does
not exist or the requested access is denied.
Solution: Verify that SCM can be run on
the host. See the associated Windows error
code for more information.
The service service name is not in stopped
state.

The service is in an invalid state.
Solution: Check the state of the service.

Failed to start the service service name. Error The agent failed to start the service.
= Error code.
Solution: See the associated Windows error
code for more information.
SQL Server Instance name is not specified.
Agent will operate on the default instance.

No value spaced-out for SQL Server
instance name. Agent would operate on the
default SQL Server instance.

Failed to set the virtual computer name in the This is a VCS internal error.
environment of the service service name. Error
Solution: Contact Symantec Technical
= Error code.
Support.
The service service name did not start within The agent failed to start the service within
the specified time limit.
the time limit as specified in the
SQLOnlineTimeout attribute.
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Table 10-5

SQL Server 2005 Agent service agent error messages (continued)

Message

Description

Failed to wait for the service service name to This is a VCS internal error.
start. Error =Error code.
Solution: Contact Symantec Technical
Support.
The service name service is not in stopped or The service is in an invalid state.
running state. State=state name.
Failed to open the service service name. Error The agent failed to open the service from
= Error code.
the Service Control Manager.
Solution: Check whether the service is
present in the Service Control Manager.
Failed to query the status of the service service The agent failed to query the state of the
name. Error = Error code.
service.
Solution: Check whether the service is
present in the Service Control Manager.
The service service name is not in running
state. Attempt to stop it might be
unsuccessful.

The SQL Server service could be in PAUSE,
PAUSE PENDING, or START PENDING
state.
Solution: Resume the service and then
attempt to stop it.

The service service name did not stop. Error
= Error code.

The agent failed to stop the service. See the
associated Windows error code for more
information.

The service service name did not stop within The agent failed to stop the service within
the specified timeout. Error = Error code.
the time limit as specified in the
SQLOfflineTimeout attribute.
Failed to remove the virtual name
environment for the service service name.

This is a VCS internal error.
Solution: Contact Symantec Technical
Support.

Agent for SQL Server 2005 Analysis service error messages
Table 10-6 describes the error messages for the SQL Server 2005 Analysis service
agent.
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Table 10-6

SQL Server 2005 Analysis service agent error messages

Message
The service cannot be started: The following
system error occurred: The requested address
is not valid in its context.

Description
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Table 10-6

SQL Server 2005 Analysis service agent error messages (continued)

Message

Description
The Windows event viewer contains this
entry if the VCS resource for the SQL
Analysis Service in a SQL Server service
group faults if the service group is
configured for a named SQL Server
instance in an IPv6 environment.
The SQL Analysis Services server
properties, IPv4 Support and IPv6 Support
determine which protocol is used by the
Analysis Server. You must manually
modify these properties to enable IPv6
support for Analysis Service.

Perform the following steps:
1

Start the Analysis Service.

2

Open SQL Server Management
Studio and connect to the Analysis
Server.

3

In the Object Explorer pane,
right-click the server to which you
have connected and click Properties.

4

On the General page, check the Show
Advanced (All) Properties check
box.

5

Locate Network \ Listener \
IPV4Support property and in the
Value field type 0.
This means that IPv4 is disabled.
Analysis Server does not listen on
IPv4 port, and clients will not be able
to connect using IPv4.

6

Locate Network \ Listener \
IPV6Support property and in the
Value field type 2.
This means that IPv6 is optional. The
Analysis Server tries to listen on
IPv6 port, but will silently ignore
errors and continue to start if IPv6
is not available.
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Table 10-6

SQL Server 2005 Analysis service agent error messages (continued)

Message

Description
7

Click OK to save the changes.

8

Stop the Analysis Service.

9

From the Cluster Manager (Java
Console), clear the fault of the
MSOLAP resource and then bring it
online.

Failed to convert the argument list. Error =
Error code.

This is a VCS internal error.

Invalid value specified for attribute attribute
name.

No value provided for the specified
attribute.

Solution: Contact Symantec Technical
Support.

Solution: Provide a value for the attribute.
Failed to initialize the SQLOlapService2005
agent.

The agent failed to initialize the
SQLOlapService2005 agent for the SQL
Server 2005 Analysis Service.
Solution: Verify whether the
SQLOlapService2005 agent exists.

Failed to open the SCM handle. Error = Error
code.

The agent fails to get a handle to the
Service Control Manager (SCM). This
could occur if the specified SCM database
does not exist or the requested access is
denied.
Solution: Verify that SCM can be run on
the host. See the associated Windows
error code for more information.

The service service name is not in stopped state. The service is in an invalid state.
Solution: Check the state of the service.
Failed to start the service service name. Error
= Error code.

The agent failed to start the service.

SQL Server Instance name is not specified.
Agent will operate on the default instance.

No value spaced-out for SQL Server
instance name. Agent would operate on
the default SQL Server instance.

Solution: See the associated Windows
error code for more information.
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Table 10-6

SQL Server 2005 Analysis service agent error messages (continued)

Message

Description

Failed to set the virtual computer name in the This is a VCS internal error.
environment of the service service name. Error
Solution: Contact Symantec Technical
= Error code.
Support.
The service service name did not start within
the specified time limit.

The agent failed to start the service within
the time limit as specified in the
SQLOnlineTimeout attribute.

Failed to wait for the service service name to
start. Error =Error code.

This is a VCS internal error.

The service name service is not in stopped or
running state. State=state name.

The service is in an invalid state.

Solution: Contact Symantec Technical
Support.

Failed to open the service service name. Error The agent failed to open the service from
= Error code.
the Service Control Manager.
Solution: Check whether the service is
present in the Service Control Manager.
Failed to query the status of the service service The agent failed to query the state of the
name. Error = Error code.
service.
Solution: Check whether the service is
present in the Service Control Manager.
The service service name is not in running
The SQL Server service could be in
state. Attempt to stop it might be unsuccessful. PAUSE, PAUSE PENDING, or START
PENDING state.
Solution: Resume the service and then
attempt to stop it.
The service service name did not stop. Error = The agent failed to stop the service. See
Error code.
the associated Windows error code for
more information.
The service service name did not stop within
the specified timeout. Error = Error code.

The agent failed to stop the service within
the time limit as specified in the
SQLOfflineTimeout attribute.

Failed to remove the virtual name environment This is a VCS internal error.
for the service service name.
Solution: Contact Symantec Technical
Support.

Appendix

A

Resource type definitions
of Agents
This appendix includes the following topics:
■

About resource type definitions of agents

■

NetApp Filer agent

■

NetApp SnapDrive agent

■

NetApp SnapMirror agent

■

Agent for SQL Server 2005 definitions

■

Agent for SQL Server 2005 Agent service definitions

■

Agent for SQL Server 2005 Analysis service definitions

■

MSDTC agent definitions

About resource type definitions of agents
This appendix lists the resource type definitions and attribute definitions of the
agents. The resource type represents the VCS configuration definition of the
agent, and specifies how the agent is defined in the configuration file main.cf.
The Attribute Definitions lists the attributes associated with the agent. The
Required attributes table lists the attributes that must be configured for the agent
to function properly.
The sample dependency graph depicts the resource types, resources, and resource
dependencies required to create the service groups.
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NetApp Filer agent
The NetApp Filer agent resource type definition and attribute definitions are as
follows. This information will assist you during the agent configuration.

NetAppFiler agent resource type definition
The NetApp Filer agent is configured as a resource of type NetAppFiler.
type NetAppFiler (
static int MonitorInterval = 30
static i18nstr ArgList[] = { FilerName, StorageIP }
static str Operations = None
str FilerName
str StorageIP
)

NetAppFiler agent attribute definitions
Table A-1 describes the NetApp Filer agent attributes.
Table A-1

NetApp Filer agent attributes

Attribute

Description

FilerName

DNS-resolvable name or IP address of the locally attached filer.
Type and dimension: string-scalar

StorageIP

The private storage IP address of the filer.
Type and dimension: string-scalar

NetApp SnapDrive agent
NetApp SnapDrive agent resource type definition and attribute definitions are as
follows. This information will assist you during the agent configuration.

NetAppSnapDrive agent resource type definition
NetApp SnapDrive agent is configured as a resource of type NetAppSnapDrive.
type NetAppSnapDrive (
static int MonitorInterval = 30
static int NumThreads = 1
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static i18nstr ArgList[] = { FilerResName,
"FilerResName:FilerName", "FilerResName:StorageIP",
VolumeName, ShareName, LUN, MountPath, Initiator,
InitiatorMonitorInterval }
str FilerResName
str VolumeName
str ShareName
str LUN
str MountPath
str Initiator[]
int InitiatorMonitorInterval = 30
)

NetAppSnapDrive agent attribute definitions
Table A-2 describes the NetApp SnapDrive agent attributes.
Table A-2

NetApp SnapDrive agent attributes

Attribute

Description

FilerResName

Name of the VCS NetAppFiler-type resource in the service group.
Type and dimension: string-scalar

VolumeName

Name of the volume containing the virtual disk. Define the volume
name in the same case as on the filer.
Type and dimension: string-scalar

ShareName

Name of the CIFS share containing the virtual disk. This attribute
is ignored if NetApp SnapDrive version 6.0 is used.
Type and dimension: string-scalar

LUN

Name of the LUN (virtual disk) on the filer that is presented to the
host for mounting. Define the LUN name in the same case as on
the filer.
Type and dimension: string-scalar

MountPath

Drive letter to be assigned to the virtual disk.
Type and dimension: string-scalar

Initiator

Name of iSCSI or FC initiator the host uses to connect virtual disks.
You can retrieve this value from the Disk Management console.
Type and dimension: string-vector
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NetApp SnapMirror agent
NetApp SnapMirror agent resource type definition and attribute definitions are
as follows. This information will assist you during the agent configuration.

NetAppSnapMirror agent resource type definition
NetApp SnapMirror agent is configured as a resource of type NetAppSnapMirror.
type NetAppSnapMirror (
static keylist SupportedActions = { fbsync }
static int MonitorInterval = 300
static int NumThreads = 1
static i18nstr ArgList[] = { FilerResName,
"FilerResName:FilerName",
"FilerResName:StorageIP",VolumeName, SnapMirrorArguments,
SnapMirrorSchedule, AppResName, VisibilityFrequency, SyncMode }
str FilerResName
str VolumeName
str SnapMirrorArguments
str SnapMirrorSchedule
str AppResName
int VisibilityFrequency = 180
str SyncMode = async
)

NetAppSnapMirror agent attribute definitions
Table A-3 describes the NetApp SnapMirror agent attributes.
Table A-3

NetApp SnapMirror agent attributes

Attribute

Description

FilerResName

Name of the VCS NetAppFiler-type resource in the group.
Type and dimension: string-scalar

VolumeName

Name of the filer volume containing the virtual disk. This is the
volume that is to be mounted. Define the volume name in the same
case as on the filer.
Type and dimension: string-scalar
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Table A-3

NetApp SnapMirror agent attributes (continued)

Attribute

Description

SnapMirrorArguments Specifies the SnapMirror arguments such as maximum transfer
speed and restart mode.
Type and dimension: string-scalar
SnapMirrorSchedule

Specifies the schedule the destination uses for updating data. Do
not assign a value for this attribute if you use SnapManager.
The schedule is in the following format:
minute hour dayofmonth dayofweek
Each field is separated by a space.
Refer to the NetApp documentation for more details on the rules
for each of these schedule fields.
By default, this attribute does not have any value.
Type and dimension: string-scalar

AppResName

Name of the resource configured to monitor the application being
made highly available.
Type and dimension: string-scalar

SyncMode

Specifies the mode of replication for the mirror.
This attribute can have the following values:
async: Indicates that the mirror should be configured in the
asynchronous mode.
■ semi-sync: Indicates that the mirror should be configured in
the semi-synchronous mode.
■ sync: Indicates that the mirror should be configured in the
synchronous mode.
■

The default is async (asynchronous) mode.
Type and dimension: string-scalar
VisibilityFrequency

Specifies how often the source snapshot will be visible on the
destination mirror. It controls the value of visibility_interval in
the snapmirror.conf file.
The default value is 180 seconds.
This attribute is applicable only if the mirror is configured in
synchronous or semi-synchronous mode.
Type and dimension: string-scalar
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Agent for SQL Server 2005 definitions
The agent for SQL Server 2005 is configured as a resource of type SQLServer2005.

Resource type definition for SQLServer2005
The resource type definition is as follows:
type SQLServer2005 (
static i18nstr ArgList[] =
{Instance,"LanmanResName:VirtualName",SQLOnlineTimeout,
SQLOfflineTimeout,DetailMonitor, SQLDetailMonitorTimeout,
Username, Domain, Password, SQLFile }
str Instance
str LanmanResName
int SQLOnlineTimeout = 90
int SQLOfflineTimeout = 90
boolean DetailMonitor = 0
boolean FaultOnDMScriptFailure = 1
int SQLDetailMonitorTimeout = 30
i18nstr Username
i18nstr Domain
str Password
i18nstr SQLFile
)

Attribute definitions for a SQLServer2005 resource type
The information below will assist you during the agent configuration.
Table A-4

SQL Server 2005 agent required attributes

Required Attributes

Type and
Dimension

Definition

Instance

string-scalar

Name of instance to monitor. If the
attribute is blank, the agent monitors
the default instance.

LanmanResName

string-scalar

The Lanman resource name on which
the SQL Server 2005 resource depends.

SQLOnlineTimeout

integer-scalar

Number of seconds that can elapse
before online entry point aborts.
Default is 90.
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Table A-4

SQL Server 2005 agent required attributes (continued)

Required Attributes

Type and
Dimension

Definition

SQLOfflineTimeout

integer-scalar

Number of seconds that can elapse
before offline entry point aborts.
Default is 90.

Table A-5

SQL Server 2005 agent optional attributes

Optional Attributes

Type and
Dimension

Definition

DetailMonitor

boolean

Defines whether the agent performs
detail monitoring of SQL Server 2005
database. The value 0 indicates the
agent will not monitor the database in
detail. The value 1 indicates the agent
will.
Default = 0.

Note: If the attribute is set to 1, the
attributes Username, Password,
Domain, SQLDetailMonitorTimeOut,
and SQLFile must be assigned
appropriate values.
FaultOnDMScriptFailure

boolean

Defines whether the agent fails over
the service group if the detail
monitoring script execution fails.
Default = 1
The value 1 indicates that the agent
fails over the service group if detail
monitoring script fails to execute. The
value 0 indicates that it does not.

SQLDetailMonitor Timeout

integer-scalar

Number of seconds that can elapse
before the detail monitor routine
aborts. Default is 30.
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Table A-5

SQL Server 2005 agent optional attributes (continued)

Optional Attributes

Type and
Dimension

Definition

Username

string-scalar

The Microsoft Windows authentication
name when logging in to a database for
detail monitoring. This attribute must
not be null if "DetailMonitor" attribute
is set to 1.

Note: This attribute can take localized
values.
Domain

string-scalar

Domain for the user account. This
attribute is used to create a trusted
connection to the SQL Server 2005
instance if "DetailMonitor" attribute is
set to 1.

Note: This attribute can take localized
values.
Password

string-scalar

Password for logging in to a database
for in-depth monitoring. This attribute
must not be null if "DetailMonitor"
attribute is set to 1.

SQLFile

string-scalar

The location of the SQLFile executed
during a monitor cycle. This attribute
must not be null if the "DetailMonitor"
attribute is set to 1.

Note: This attribute can take localized
values.

Sample dependency graph for SQL Server 2005
The following example describes typical service groups configured to monitor the
state of SQL Server 2005 in a VCS cluster. A sample configuration graphically
depicts the resources and their dependencies within the service group. For more
information about these resources and resource types, see the chapter VCS
Resource Types and Agents in the Veritas Cluster Server Administrator’s Guide.
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Figure A-1

SQL Server 2005 service group dependency graph
SQLServer2005

Lanman

RegRep
NetAppSnapDrive

IP
RegRepNetAppSnapDrive

NIC

NetAppSnapMirror

NetAppFiler

The virtual name for the SQL Server is created using the Lanman resource. The
service group IP address for the SQL Server is configured using the IP and NIC
resources. The Netapp SnapDrive mount point is created using the
NetappSnapDrive resource. SQL Server 2005 registry is replicated using the
RegRep and RegRepNetAppSnapDrive resources. The SQL Server 2005 resource
comes online after each of these resources are brought online.

Agent for SQL Server 2005 Agent service definitions
The agent for SQL Server 2005 Agent service is configured as a resource of type
SQLAgService2005.

Resource type definition for SQLAgService2005
The resource type definition is as follows:
type SQLAgService2005 (
static i18nstr ArgList[] = {"SQLServer2005ResName:Instance",
"LanmanResName:VirtualName" }
str SQLServer2005ResName
str LanmanResName
)
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Attribute definitions for a SQLAgService2005 resource type
The information below will assist you during the agent configuration.
Table A-6

SQL Server 2005 Agent service agent required attributes

Required Attributes

Type and
Dimension

Definition

SQLServer2005ResName

string-scalar

The name of the SQLServer2005
resource on which the SQL Server 2005
Agent service resource depends.

LanmanResName

string-scalar

The Lanman resource name on which
the SQL Server 2005 resource depends.

Sample dependency graph for SQL Server 2005 Agent service
The following example describes typical service groups configured to monitor the
state of SQL Server 2005 Agent service in a VCS cluster. A sample configuration
graphically depicts the resources and their dependencies within the service group.
For more information about these resources and resource types, see the chapter
VCS Resource Types and Agents in the Veritas Cluster Server Administrator’s
Guide.
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Figure A-2

SQL Server 2005 Agent Service service group dependency graph
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The virtual name for the SQL Server is created using the Lanman resource. The
service group IP address for the SQL Server is configured using the IP and NIC
resources. The Netapp SnapDrive mount point is created using the
NetappSnapDrive resource. SQL Server 2005 registry is replicated using the
RegRep and RegRepNetAppSnapDrive resources.The SQL Server 2005 Agent
service resource depends on the SQL Server 2005 resource. The SQL Server 2005
Agent service resource comes online after each of these resources are brought
online.

Agent for SQL Server 2005 Analysis service definitions
The agent for SQL Server 2005 Analysis service is configured as a resource of type
SQLOlapService2005.

Resource type definition for SQLOlapService2005
The resource type definition is as follows:
type SQLOlapService2005 (
static i18nstr ArgList[] = {"SQLServer2005ResName:Instance",
"LanmanResName:VirtualName" }
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str SQLServer2005ResName
str LanmanResName
)

Attribute definitions for a SQLOlapService2005 resource type
This information will assist you during the agent configuration.
Table A-7

SQL Server 2005 Analysis service agent required attributes

Required Attributes

Type and
Dimension

Definition

SQLServer2005ResName

string-scalar

The name of the SQLServer2005
resource on which the SQL Server 2005
Analysis service resource depends.

LanmanResName

string-scalar

The Lanman resource name on which
the SQL Server 2005 resource depends.

Sample dependency graph for SQL Server 2005 Analysis service
The following example describes typical service groups configured to monitor the
state of SQL Server 2005 Analysis service in a VCS cluster. A sample configuration
graphically depicts the resources and their dependencies within the service group.
For more information about these resources and resource types, see the chapter
VCS Resource Types and Agents in the Veritas Cluster Server Administrator’s
Guide.
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Figure A-3

SQL Server 2005 Analysis Service service group dependency graph
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The virtual name for the SQL Server is created using the Lanman resource. The
service group IP address for the SQL Server is configured using the IP and NIC
resources. The Netapp SnapDrive mount point is created using the
NetappSnapDrive resource. SQL Server 2005 registry is replicated using the
RegRep and RegRepNetAppSnapDrive resources.The SQL Server 2005 Analysis
service resource depends on the SQL Server 2005 resource. The SQL Server 2005
Analysis service resource comes online after each of these resources are brought
online.

MSDTC agent definitions
The MSDTC agent is configured as a resource of type MSDTC.

Resource type definition for MSDTC
The resource type definition is as follows:
type MSDTC (
static i18nstr ArgList[] = {"LanmanResName:VirtualName",
"MountResName:MountPath", LogPath }
str LanmanResName
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str MountResName
i18nstr LogPath
)

Attribute definitions for an MSDTC resource type
This information will assist you during the agent configuration.
Table A-8

MSDTC agent required attributes

Required Attributes

Type and
Dimension

Definition

LanmanResName

string-scalar

Name of the Lanman resource on which
the MSDTC resource depends.

MountResName

string-scalar

The mount resource name on which the
MSDTC resource depends.

LogPath

string-scalar

The path for MSDTC logs. This attribute
can take localized values.

Sample dependency graph for MSDTC service group
The following examples describe typical service groups configured to monitor the
state of an MSDTC service group in a VCS cluster. A sample configuration
graphically depicts the resources and their dependencies within the service group.
For more information about these resources and resource types, see the chapter
VCS Resource Types and Agents in the Veritas Cluster Server Administrator’s
Guide.
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Figure A-4

MSDTC service group dependency graph
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The virtual name for the MSDTC Server is created using the Lanman resource.
The service group IP address for the MSDTC Server is configured using the IP and
NIC resources. The Netapp SnapDrive mount point is created using the
NetappSnapDrive resource. MSDTC registry is replicated using the RegRep and
RegRepNetAppSnapDrive resources. The MSDTC resource comes online after
each of these resources are brought online.
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Using the virtual MMC
viewer
This appendix includes the following topics:
■

About using the virtual MMC viewer

■

Viewing DTC transaction information

About using the virtual MMC viewer
VCS starts the MSDTC service in the cluster under the context of the virtual server.
Because the MMC snap-in is not aware of such a configuration, it is not possible
to view the transactions on the DTC virtual server from a node where the MSDTC
resource is online. VCS provides a virtual MMC viewer, the VCS Application
Manager (VAM) utility, that enables you to view the distributed transaction
statistics on the DTC virtual server from a node where the MSDTC resource is
online.

Viewing DTC transaction information
In cases where a communication line fails or a distributed transaction application
leaves unresolved transactions, you might want to view transaction lists and
statistics, control which transactions are displayed, set transaction time-out
periods, and control how often transactions are updated. The following steps
describe how to view the DTC transactions information.
Prerequisites for viewing DTC transaction information are as follows:
■

An MSDTC service group must be configured and online in the cluster.
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■

MSDTC client must be configured on the nodes on which you wish to view the
transactions.

■

The MSDTC service group must be online on the node where you run the VCS
Application Manager utility.

To view transactions from a node where MSDTC resource is online

1

Start the VCS Application Manager utility.
Click Start > Programs > Symantec > Veritas Cluster Server > Configuration
Tools > Application Manager.
The VCS Application Manager displays a list of supported application service
groups configured in the cluster. For each service group it also displays the
state of the service group, the name of the virtual server resource (Lanman
resource) and the corresponding management tools used for that application.

2

Select MSDTC from the Select the resource type drop-down list.

3

Select the MSDTC resource that is online and then click Manage, or
double-click the MSDTC resource name.
VAM launches the Component Services snap-in in the virtual server context.

4

In the console tree of the Component Services administrative tool, expand
Component Services > Computers > My Computer > Distributed Transaction
Coordinator > Local DTC.

5

Click Transaction List to view all transactions, their status, and their
identifiers. Right-click a transaction and click View > Properties to list the
parent transaction and its children.

6

Click Transaction Statistics to view statistical information about the
transactions in which a server participated.
You can use transaction statistics to get an overview of DTC performance.
Refer to the Microsoft documentation for further information.

The following steps describe how to view DTC transactions from nodes that are
not part of the MSDTC Server service group.
To view transactions from any node in the domain

1

Launch the Windows Component Services Administrative tool.
Click Start > Programs > Administrative Tools > Component Services.

2

In the console tree of the Component Services administrative tool, double-click
Component Services, right-click Computers, click New > Computer.

Using the virtual MMC viewer
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3

In the Add Computer dialog box, specify the virtual server name that you
specified while creating the MSDTC Server service group. If you are unsure
of the exact name, click Browse to search from a list of all computers on the
network and select the virtual computer name from the list.

4

Click OK. The virtual computer entry is added to the Computers container.

5

Expand the newly added virtual computer entry and double-click Distributed
Transaction Coordinator.

6

Click Transaction List to view all transactions, their status, and their
identifiers. Right-click a transaction and click View > Properties to list the
parent transaction and its children.

7

Click Transaction Statistics to view statistical information about the
transactions in which a server participated.
You can use transaction statistics to get an overview of DTC performance.
Refer to the Microsoft documentation for further information.

149

150

Using the virtual MMC viewer
Viewing DTC transaction information

Appendix

C

Sample configurations
This appendix includes the following topics:
■

About sample configurations for SQL Server 2005

■

Sample configuration for a SQL Server 2005 cluster

About sample configurations for SQL Server 2005
The sample configurations in this appendix describe typical service groups
configured to monitor the state of SQL Server 2005 in a VCS cluster using NetApp
Filers to manage shared storage.

Sample configuration for a SQL Server 2005 cluster
The following sample configuration depicts a two node SQL Server cluster with
MSDTC server configured. A SQL Server service group with MSSearch service,
SQL Server Agent service, and SQL Server Analysis service is configured is
configured in the cluster. The MSDTC service group is also configured on the
same nodes.
include "types.cf"
cluster clnew4533 (
UserNames = { a = eHHb }
ClusterAddress = "10.217.60.166"
Administrators = { a }
)
remotecluster clremote (
ClusterAddress = "10.217.119.60"
)
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heartbeat Icmp (
ClusterList = { clremote }
AYATimeout = 30
Arguments @clremote = { "10.217.119.60" }
)
system VCSW2K246 (
)
system VCSW2K247 (
)
group sqlg (
SystemList = { VCSW2K246 = 0, VCSW2K247 = 1 }
ClusterList = { clnew4533 = 1, clremote = 0 }
Authority = 1
ClusterFailOverPolicy = Auto
)
IP sqlg-IP (
Address = "10.217.60.167"
SubNetMask = "255.255.252.0"
MACAddress @VCSW2K246 = "00-0B-DB-95-9E-6C"
MACAddress @VCSW2K247 = "00-0B-DB-95-9D-F4"
)
Lanman sqlg-Lanman (
VirtualName = VHD
IPResName = sqlg-IP
)
NIC sqlg-NIC (
MACAddress @VCSW2K246 = "00-0B-DB-95-9E-6C"
MACAddress @VCSW2K247 = "00-0B-DB-95-9D-F4"
)
NetAppFiler sqlg-NetAppFiler (
FilerName = vcsfiler01
StorageIP = "10.217.60.153"
)

Sample configurations
Sample configuration for a SQL Server 2005 cluster

NetAppSnapDrive sqlg-NetAppSnapDrive (
Critical = 0
FilerResName = sqlg-NetAppFiler
VolumeName = vol3
ShareName = data03
LUN = "d30.lun"
MountPath = I
Initiator @VCSW2K246 =
"iqn.1991-05.com.microsoft:vcsw2k246.vcs.dev"
Initiator @VCSW2K247 =
"iqn.1991-05.com.microsoft:vcsw2k247.vcs.dev"
)
NetAppSnapDrive sqlg-NetAppSnapDrive-1 (
Critical = 0
FilerResName = sqlg-NetAppFiler
VolumeName = vol3
ShareName = data03
LUN = "d31.lun"
MountPath = J
Initiator @VCSW2K246 =
"iqn.1991-05.com.microsoft:vcsw2k246.vcs.dev"
Initiator @VCSW2K247 =
"iqn.1991-05.com.microsoft:vcsw2k247.vcs.dev"
)
NetAppSnapMirror sqlg-NetAppSnapMirror (
FilerResName = sqlg-NetAppFiler
VolumeName = vol3
)
RegRep sqlg-RegRep-MSSQL (
MountResName = sqlg-NetAppSnapDrive-1
ReplicationDirectory = "\\RegRep\\sqlg-RegRep-MSSQL"
Keys @VCSW2K246 = {"HKLM\\SOFTWARE\\Microsoft\\Microsoft
SQL Server\\MSSQL.1\\MSSQLServer" =
"SaveRestoreFile:sqlg-RegRep-MSSQL_MSSQLServer.reg",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\PROVIDERS" =
"SaveRestoreFile:sqlg-RegRep-MSSQL_PROVIDERS.reg",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\Replication" =
"SaveRestoreFile:sqlg-RegRep-MSSQL_Replication.reg",
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"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\SQLServerAgent" =
"SaveRestoreFile:sqlg-RegRep-MSSQL_SQLServerAgent.reg",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\SQLServerSCP" =
"SaveRestoreFile:sqlg-RegRep-MSSQL_SQLServerSCP.reg" }
Keys @VCSW2K247 = {
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\MSSQLServer" =
"SaveRestoreFile:sqlg-RegRep-MSSQL_MSSQLServer.reg",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\PROVIDERS" =
"SaveRestoreFile:sqlg-RegRep-MSSQL_PROVIDERS.reg",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\Replication" =
"SaveRestoreFile:sqlg-RegRep-MSSQL_Replication.reg",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\SQLServerAgent" =
"SaveRestoreFile:sqlg-RegRep-MSSQL_SQLServerAgent.reg",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\SQLServerSCP" =
"SaveRestoreFile:sqlg-RegRep-MSSQL_SQLServerSCP.reg" }
ExcludeKeys = { "" }
)
SQLServer2005 sqlg-SQLServer2005 (
Critical = 0
Instance = HD
LanmanResName = sqlg-Lanman
)
sqlg-SQLServer2005 requires sqlg-RegRep-MSSQL
sqlg-SQLServer2005 requires sqlg-Lanman
sqlg-SQLServer2005 requires sqlg-NetAppSnapDrive
sqlg-NetAppSnapDrive requires sqlg-NetAppSnapMirror
sqlg-RegRep-MSSQL requires sqlg-NetAppSnapDrive-1
sqlg-NetAppSnapDrive-1 requires sqlg-NetAppSnapMirror
sqlg-IP requires sqlg-NIC
sqlg-Lanman requires sqlg-IP
sqlg-NetAppSnapMirror requires sqlg-NetAppFiler

// resource dependency tree

Sample configurations
Sample configuration for a SQL Server 2005 cluster

//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//

group sqlg
{
SQLServer2005 sqlg-SQLServer2005
{
RegRep sqlg-RegRep-MSSQL
{
NetAppSnapDrive sqlg-NetAppSnapDrive-1
{
NetAppSnapMirror sqlg-NetAppSnapMirror
{
NetAppFiler sqlg-NetAppFiler
}
}
}
Lanman sqlg-Lanman
{
IP sqlg-IP
{
NIC sqlg-NIC
}
}
NetAppSnapDrive sqlg-NetAppSnapDrive
{
NetAppSnapMirror sqlg-NetAppSnapMirror
{
NetAppFiler sqlg-NetAppFiler
}
}
}
}
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